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Introduction
Product description

The MGX Series is a digital mixing console that can be used in a variety of scenes, from PA work for small live
events and facility audio to home recording, music production, podcasting and streaming.

This unit features USB audio interface functionality, so that with just this unit, you can handle audio in hybrid
live performances and streaming, for both in-person and online events.

A single console for live sound PA work, podcast streaming, recording and production
The MGX Series offers powerful and flexible connection and routing options for live PA, online streaming and
music production, all in one unit. You can use just this unit to cleanly handle a diverse range of audio needs,
including multiple devices and the internal audio from a computer.

Two USB ports (MAIN and SUB) are available for collecting audio signals from two devices such as a
computer or smartphone, or for creating a system for recording to a sub device and for streaming.

This unit also features multitrack recording functions using an SD card, and the MGX16V and MGX12V feature
capture and thru output for HDMI video signals. With just this unit, you can create a production and
streaming system that lets you create backup recordings as well as process video signals.

Intuitive hybrid operations
The MGX Series features a touch panel as well as physical controllers and knobs, including basic channel
faders and knobs that are normally expected from a mixer that let you operate this unit in an intuitive way.
All of this lets you smoothly give shape to onstage and streaming as well as music production.

Built-in DSP for a more polished sound and a stronger performance
The MGX Series features a built-in custom DSP chip (the SSP3) to offer professional sound quality that adds
the finishing touch to your sound in any scene, from recording to music production to livestreaming. This
unit also offers the ideal latency characteristics along with a high-definition monitoring environment for live
and streamed performances.

Trusted solutions brought to you by Yamaha and Steinberg
Yamaha and Steinberg bring together the technologies and strengths they have created through their
respective expertise in hardware and software, offering solutions that support the creative activities of users
through collaboration between established industry brands and software such as Elgato and OBS Studio.
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How the manuals are organized
The manuals that cover this product are listed below.

Printed manuals
( Safety Guide (included)

Contains the information necessary for you to safely use this product. Make sure to read this before use.
( Start Guide (included)

Explains the operations you must do first after purchasing this product.

Online manuals
( Setup Guide

Explains the steps to take for getting ready to use this product, and how to download the bundled
software. Access this guide by opening the “Getting Started” file in the USB drive of this unit, or by clicking
the following link.
https://manual.yamaha.com/audio/portable_pa_systems/mgx16_mgx12/sp/

( User Guide (this guide)
Explains all of the functions of this product.

( Effect Reference Guide
Explains the effect parameters in detail. Access this guide from the following link.
https://manual.yamaha.com/audio/music_audio_production/effect_rg/

( Technical Specifications (English only)
Contains a list of specifications, a block diagram, dimensions and other materials. Access this information
from the following link.
https://www.yamaha.com/2/mgx/

Please keep the included manuals in a safe place where you can easily access them at any time. You can
download these manuals from the Yamaha website. Use this information as necessary.

https://download.yamaha.com/
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Accessories
This product includes the following accessories. Check whether all of these items have been properly
packaged with the product.

( Power adapter (including power cord) × 1
( Safety Guide × 1
( Start Guide × 1
( Cubase AI License Card × 1
( Basic FX Suite License Card × 1
( Steinberg Plus License Card × 1
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Notations used in this guide
( In this guide, the names of controls on the panel as well as the virtual buttons and knobs shown onscreen

are shown inside brackets [ ]. The section name may be written in front of the brackets for some controls
(example: USER DEFINED KEYS [1] key).

( If the specifications vary depending on the model as explained in the text, the model in question is
indicated in parentheses (example: [MIC/LINE  INPUT 1‐8] connector (MGX16V, MGX16)/[MIC/LINE  INPUT
1‐4] connectors (MGX12V, MGX12)).

( In this document, “MGX Series” is used when referring to all models. Also, “video models” is used when
referring to both the MGX16V and MGX12V.

( Unless otherwise specified, the illustrations used are from the MGX16V.
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Note

n Data copyrights
( The software and this guide may not be reproduced or modified, in whole or in part without permission.
( Except as permitted by copyright laws and other relevant laws, it is prohibited to reproduce or transfer

third-party contents (commercially available music, sound data, video, etc.) without the permission of the
copyright holder.

n Protection of copyright
( Do not use this product for any purpose that may infringe upon the rights of any third party, including

copyrights, as established by law in each country or region.
( Yamaha bears no responsibility for any infringement upon third party rights that may occur as a result of

using this product.

n Notice regarding the contents of this guide
( The precautions and other matters in this guide are classified as follows.

( WARNING
This content indicates “risk of serious injury or death.”

( CAUTION
This content indicates “risk of injury.”

( NOTICE
Indicates points that you must observe in order to prevent product failure, damage or malfunction and
data loss, as well as to protect the environment.

( NOTE
Indicates notes on instructions, restrictions on functions, and additional information that may be helpful.

( All illustrations and screens shown in this guide are for explanatory purposes.

n Notice regarding silicone buttons

The silicone buttons of this product are coated on their surface to maintain quality. The chemical
components may be visible on the surface depending on your storage and usage environment, and may
appear as a cloudy white coloration. Please be assured that this has no effect on the user’s safety, the
product’s performance or functionality. If you are concerned about the appearance, wipe it with a dry soft
cloth or a soft cloth dampened with water and wrung out tightly.
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About the software
Various bundled software is included with the MGX Series.

Refer to the Setup Guide for details on each software title.

To access the Setup Guide, open the “Getting Started” file in the USB drive of this unit, or click the following
link.

https://manual.yamaha.com/audio/portable_pa_systems/mgx16_mgx12/sp/
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Controls and functions
Top panel

Overview of the top panel

NOTE
The MGX16V is shown in the illustration. The actual number of input/output connectors depends on the model.

h i k m a

b
c

d
e

fg

j

l

a Display
This is a color LCD screen that features an electrostatic touch panel. The panel will not operate correctly if you are
wearing gloves or other hand coverings.

NOTICE
( Do not use a sharp object or hard objects such as your fingernails to operate the screen. Doing so may scratch the screen or

cause the touch panel to stop working.

NOTE
Remove the transparent protective film that was applied to the display prior to shipment from the factory.
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b Multi-function knobs
These knobs control four of the main parameters shown on the display.

c [TOUCH AND TURN] knob
Operates the parameter you select on the display.

d [z] (power) switch (p.23)
Switches the power on/off. This lights up when the power is on.

When this product will not be used for a long time, always unplug the power cord from the outlet.

e [ ] (HOME) key
Returns the screen display to the HOME (Mixer) top screen.

f [USER DEFINED KEYS] (p.16)
These keys are for operating functions assigned by the user. Use the [BANK] select keys to switch between the banks
to operate.

g Channel strip section (p.16)
This operates the main parameters of each channel.

h [MIC/LINE  INPUT 1–8] connectors (MGX16V, MGX16)
[MIC/LINE  INPUT 1–4] connectors (MGX12V, MGX12)
Connect your mics and musical instruments here. These are combo connectors that are compatible with both XLR-
type and TRS phone plugs.

i [LINE  INPUT 9/10, 11/12] connectors (MGX16V, MGX16)
[LINE  INPUT 5/6, 7/8] connectors (MGX12V, MGX12)
These are balanced TRS phone connectors for inputting line-level signals from musical instruments, audio players
and so forth.

j [LINE  INPUT 13/14, 15/16] connectors (MGX16V, MGX16)
[LINE  INPUT 9/10, 11/12] connectors (MGX12V, MGX12)
These are RCA connectors for inputting line-level signals from musical instruments, audio players and so forth.

k [STEREO OUT L/R] connectors
These are XLR-3-32 type output connectors for outputting analog audio signals. These connectors are used for
outputting the STEREO channel signal.

l [OMNI OUT 1–8] connectors (MGX16V, MGX16)
[OMNI OUT 1–6] connectors (MGX12V, MGX12)
These are TRS phone connectors for outputting analog audio signals. These connectors are primarily for outputting
the MIX and STEREO channel signals.

m [PHONES 1–4] connectors
Connect your headphones to these TRS phone connectors.
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Channel strip section
This operates the main parameters of each channel.

e

a

b

c

d

a [SEND] knob
Adjusts the send level. The send level is indicated by the LED. Select the send destination from the [Sends] button in
the side menu of the HOME screen (p.50).

b [SEL] key
Use the [SEL] key to select which channel is operated by the display. For stereo channels, this switches between the L
and R channels each time you press the [SEL] key.

c [CUE] key
Selects the channel to monitor from each channel. The indicator lights up for the channels that are selected.

d [ON] key
Toggles the on/off for each channel. The indicator lights up for channels that are set to be on.

e Channel fader
Adjusts the level of signal for each channel that’s sent to the STEREO bus.
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[USER DEFINED KEYS BANK] section

a

b

a [BANK] select keys
Selects the bank (A–D) of the [USER DEFINED KEYS]. The LED brightness changes according to the bank (A–D).

BANK A BANK B BANK C BANK D

b [USER DEFINED KEYS 1–8]
These eight switches are for executing functions assigned by the user.

For how to assign the functions and operate the switches, refer to “Other operations” → “Assigning functions to the
user defined keys” (p.166).
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Rear panel
MGX16V, MGX12V

a

e f g h

c db

MGX16, MGX12

a b

e f

c d

a [16V] DC IN connector
Connect the included power adapter here.

b Cord hook
This hook is for attaching the power adapter cord. This makes it more difficult to accidentally pull out the plug.

c [microSD] slot
Use this slot to insert a microSD card.

d [USB SUB] port (USB-C™)
Connect this port to the USB port on your computer (either USB-C or USB-A) with a USB-C to USB-C cable or a USB-A
to USB-C cable.
Connect a computer or mobile device to transmit and receive 2 in/2 out, 48 kHz, 16-bit audio signals.

When using a mobile device such as an iPad, iPhone or Android device, directly connect the USB-C port of your device
with a USB-C to USB-C cable to the USB-C port. If the device does not have a USB-C port, connect and use a suitable
adapter (p.30).
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NOTICE
( USB bus power is not supported.
( Do not connect any devices other than a computer, a mobile device such as an iPad, iPhone or Android device, or a console

gaming device.
( When connecting to a computer, perform the following steps to prevent data loss in the event that the computer or this product

stops (hangs up).
( Use a USB cable less than 3 meters long.
( Before plugging in or unplugging a USB cable, make sure to quit all applications.
( Before plugging a cable into the [USB SUB] port, turn off the [z] (power) switch or turn the volume all the way down.
( Wait at least six seconds between turning this product’s power on/off or plugging in/unplugging a USB cable.

( If your computer or this product hangs up, restart the application or your computer, or turn this product off and on again.

e Ventilation ports
This product is equipped with a cooling fan. When it gets too hot inside, the fan starts automatically. This blows air
out of the unit, so make sure that nothing is blocking the flow of air from the exhaust ports.

CAUTION
( Do not block the ventilation ports (heat dissipating slits) of this product. This unit features ventilation ports on the rear panel to

prevent the inside from getting too hot. If the ventilation ports are covered, heat gets trapped inside the product, which may
result in malfunction and/or fire.

f [USB MAIN] port (USB-C)
Connect this port to the USB port on your computer (either USB-C or USB-A) with a USB-C to USB-C cable or a USB-A
to USB-C cable.

By connecting a computer or other device, you can transmit and receive a maximum of 22 in/22 out (MGX16V, MGX16)
or 18 in/18 out (MGX12V, MGX12), 44.1/48/88.2/96 kHz, 32-bit audio signals. The video models let you transmit video
that’s input from the [HDMI IN] connector.

When using a mobile device such as an iPad or iPhone, directly connect the USB-C port of your device with a USB-C to
USB-C cable.

NOTICE
( USB bus power is not supported.
( Do not connect any devices besides a computer, iPhone or iPad.
( When connecting to a computer, perform the following steps to prevent data loss in the event that the computer or this product

stops (hangs up).
( Use a USB cable less than 3 meters long.
( Before plugging in or unplugging a USB cable, make sure to quit all applications.
( Before plugging a cable into the [USB MAIN] port, turn off the [z] (power) switch or turn the volume all the way down.
( Wait at least six seconds between turning this product’s power on/off or plugging in/unplugging a USB cable.
( If your computer or this product hangs up, restart the application or your computer, or turn this product off and on again.

g [HDMI THRU] connector (MGX16V, MGX12V)
Connect the HDMI input connector of your monitor display or similar device here with an HDMI cable.

h [HDMI IN] connector (MGX16V, MGX12V)
Connect the HDMI output connector of your camera, Blu-ray player, console game or other device here with an HDMI
cable.
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Getting ready
Installing TOOLS for MGX/URX

TOOLS for MGX/URX is a software package that’s necessary for connecting and using this product with your
computer. Follow the steps below to install TOOLS for MGX/URX on your computer.

1 Access the following website to download TOOLS for MGX/URX.

https://www.yamaha.com/2/mgx/

2 Decompress (extract) the downloaded file.

3 Launch TOOLS for MGX/URX Installer.

4 Follow the onscreen instructions to install the software.
This completes the installation of TOOLS for MGX/URX.
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Connect the power adapter
Connect the included power adapter to the DC IN connector on the rear panel of the unit in the order shown
in the illustration below.

1 3
22

Power adapter

To AC outlet

Power plug

NOTE
( When unplugging the power adapter or power cord, turn off the power and perform the steps in reverse.
( The power plug may be shaped differently depending on the country or region.
( Attaching the power adapter cord to the hook makes it more difficult to accidentally pull out the plug.

WARNING
( Make sure to use the power adapter and power cord that were included with this unit. Using a different power adapter or power

cord may result in product failure, overheating, fire or other issues.
( Place the unit close to the AC outlet. If you sense any abnormalities, immediately turn off the power switch and unplug the

power cord from the AC outlet.

NOTICE
( A small amount of power flows even when this unit is off. When this product will not be used for a long time, be sure to unplug

the power adapter from the outlet.
( Do not wrap the power adapter cord tightly while it is attached to the hook, or pull on the cord. This may cause wear and tear

on the cord’s surface, or damage the hook.
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n Precautions regarding the placement of the power adapter

As shown in the illustration below, the power adapter cord should be placed at least 10 cm away from the
power adapter. Failure to do so may cause other devices around the power adapter to malfunction or
temporarily exhibit reduced performance as a result of the radio waves emitted by the power adapter.

Power adapter

At least 10 cm

Rear panel
DC IN connector

To AC outlet
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Turning the power on/off

WARNING
( Be sure to turn the device’s volume all the way down before turning on the power. Failure to do so may cause hearing loss,

electric shock or equipment damage.

Power on
Press the [z] (power) switch on the top panel. The [z] (power) switch lights up.

NOTE
When you turn on this product for the first time, a screen will appear, prompting you to set the language, date and time, and operation
mode (p.39). Follow the onscreen instructions.

Power off
Long-press the [z] (power) switch on the top panel. When you follow the instructions on the display and
select [OK], the [z] (power) switch goes dark.

NOTICE
( Repeatedly toggling the [z] (power) switch on/off in rapid succession may cause a malfunction.
( Wait at least six seconds after turning off the [z] (power) switch before turning it back on.
( To turn off the power, make sure to hold down the [z] (power) switch on the top panel, and follow the instructions on the

display.
( If you cause the power to be directly interrupted, such as by unplugging the power adapter, this may cause the data backup to

fail, or this might damage the file system of the microSD card.
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Connecting to your computer

What you need
( Windows or Mac computer (connected to the Internet)
( Commercially available USB cable that meets the standards below (USB-C to USB-C, or USB-A to USB-C)

MGX16, MGX12: USB 2.0 (High Speed) or greater
MGX16V, MGX12V: USB 3.0 (Super Speed) supported

1 Connect the USB MAIN port on the rear panel to the USB port on your computer.

Computer

MGX16V, MGX12V

MGX16, MGX12

2 Press the [z] (power) switch on the top panel to turn the power on.

WARNING
( Be sure to turn the device’s volume all the way down before turning on the power. Failure to do so may cause hearing loss,

electric shock or equipment damage.

3 When using USB Audio, configure the settings on your computer in “Sound”
(Windows) or “Audio Devices” (Mac) (p.28, p.29).
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Updating the firmware
The firmware of this product is designed to be updated for improved operability, added functionality and to
correct problems.

Make sure to update the firmware to the latest version to ensure optimum use of all the features of this
product.

Refer to “p.167” in “Other operations” for how to update the firmware.
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Making connections
Connecting to an analog input/output

n Example of connecting to an analog input

Connect a mic, electronic musical instrument, audio device or other line-level equipment to the INPUT
connectors.

Synthesizer

Portable player

Electric-
acoustic guitar

Microphone

n Example of connecting to an analog output

Connect your speakers or headphones to the OUT connectors.

Main speakers

Monitor speakers

Headphones
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About the USB cables to use
( The USB ports on this product are USB-C type ports. This product does not include USB cables, so you will

need a commercially available USB-C to USB-C cable or a USB-A to USB-C cable.
( Use a USB cable less than three meters long.
( When using the MGX16V or MGX12V, the USB MAIN port requires a USB cable that supports USB 3.0 or

greater, and the USB SUB port requires a USB cable that supports USB 2.0 or greater.
( When using the MGX16 or MGX12, both the USB MAIN and USB SUB port require a USB cable that supports

USB 2.0 or greater.
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Connecting to your computer (Windows)
When you first install “TOOLS for MGX/URX”, the “Yamaha Steinberg USB Driver” is automatically installed so
that your computer can recognize this product. Download and install the “TOOLS for MGX/URX” from the
following website.

https://www.yamaha.com/2/mgx/

Refer to “Getting ready” → “Connecting to your computer” (p.24) for how to connect this unit to your
computer.

NOTE
( The steps may differ depending on your computer’s OS and settings.
( For a list of compatible operating systems, see the Yamaha website listed above.

Settings on the computer
Change the output/input setting on your computer to “MGX”.

1 From the “Start” menu, open “Settings”.

2 Select “System” → “Sound”.

3 On the “Sound” screen, select A–C “Yamaha MGX**” as the output/input device.

The asterisks (**) represent the model name (16V, 16, 12V, 12).

4 Close the “Sound” settings.

About the signal names on the computer and this unit’s display
Refer to the “USB MAIN signal name reference table” (p.200) for the names of signals shown on the
computer’s sound/DAW app and on this unit’s display as the Input Source .

Select the input source for each channel on the INPUT screen (p.106).
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Connecting to your computer (Mac)
When you first install “TOOLS for MGX/URX”, the “Yamaha Steinberg USB Driver” is automatically installed so
that your computer can recognize this product. Download and install the “TOOLS for MGX/URX” from the
following website.

https://www.yamaha.com/2/mgx/

Refer to “Getting ready” → “Connecting to your computer” (p.24) for how to connect this unit to your
computer.

NOTE
( For a list of compatible operating systems, see the Yamaha website listed above.
( If you are using a Mac that doesn’t have a USB-C port, use a commercially available USB-A to USB-C cable to connect the devices.

Settings on the computer

1 Open “Finder” → “Go” → “Applications” → “Utilities” → “Audio MIDI Setup”.

2 From the list of audio devices on the left side of the screen, select Yamaha MGX**
DAW or Yamaha MGX** A–C.

The asterisks (**) represent the model name (16V, 16, 12V, 12).

If the audio devices screen is not shown, select “Window” → “Show Audio Devices” from the
menu to make it appear.

3 Click [ ] at the bottom left of the screen and select “Use This Device For Sound
Output”.

4 Similarly, select “Use This Device For Sound Input”.

Once you’ve finished steps 3 and 4, the mic and speaker icons at the bottom right of [Yamaha
MGX**] in the list appear.

5 Quit “Audio MIDI Setup.”

About the signal names on the computer and this unit’s display
Refer to the “USB MAIN signal name reference table” (p.200) for the names of signals shown on the
computer’s sound/DAW app and on this unit’s display as the Input Source . Select the input source for each
channel on the INPUT screen (p.106).
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Connecting to a mobile device

NOTE
For a list of compatible operating systems, see the following Yamaha website.
( https://www.yamaha.com/2/mgx/

n iPad, iPhone and Android devices with a USB-C port

What you need
( USB-C to USB-C cable (commercially available)

( MGX16, MGX12: USB 2.0 (High Speed) or greater
( MGX16V, MGX12V: USB 3.0 (Super Speed) supported

1 Use a commercially available USB-C to USB-C cable to connect [USB MAIN] port or
the [USB SUB] port on this product to your iPad/iPhone. Connect your Android
device to the [USB SUB] port on this product.

USB-C to USB-C Cable

This product is automatically recognized by the iPad, iPhone or Android device once connected.

There is no need to configure any settings on the iPad, iPhone or Android device.

NOTE
If you will be streaming or using your device for long periods of time, we recommend supplying power to the device while it is in use.
Use a USB-C Digital AV Multiport Adapter (commercially available) made by Apple for iPad/iPhone, or a commercially available audio
conversion adapter that supports USB Power Delivery (USB PD) or the like for Android devices.

n iPad/iPhone devices with a Lightning port

What you need
( Lightning to USB 3 Camera Adapter made by Apple (commercially available)
( USB-A to USB-C cable (commercially available)

( MGX16, MGX12: USB 2.0 (High Speed) or greater
( MGX16V, MGX12V: USB 3.0 (Super Speed) supported
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1 Use a commercially available USB-A to USB-C cable to connect the [USB MAIN] port
or the [USB SUB] port on this product to an Apple Lightning to USB 3 Camera
Adapter made by Apple.

2 Connect the Apple Lightning to USB 3 Camera Adapter made by Apple to the iPad/
iPhone.

iPad/iPhoneUSB-A to USB-C cable

Lightning to USB 3 Camera Adapter

This product is automatically recognized by the iPad/iPhone once connected.

There is no need to configure any settings on the iPad/iPhone.

About the signal names on the iPad/iPhone and on this unit’s display
For the signal names that you can see in the DAW app on your iPad/iPhone as well as the signal names that
are shown on this unit’s display as the Input Source , refer to the “USB MAIN signal name reference
table” (p.200).

Select the input source for each channel on the INPUT screen (p.106).
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Connecting to video devices (for video models)

n Connection example

Video camera Home
gaming device

Monitor display

Computer

( The video signals that are input to the [HDMI IN] connector are passed through to the [HDMI THRU]
connector as-is. The signals are converted to UVC video format, and are output to your computer from the
[USB MAIN] port.

( The audio signals that are input to the [HDMI IN] connector are down-mixed, and are brought into the
input channel as a selection for input select on the mixer. The signal is output from the [HDMI THRU]
connector as-is only when two-channel audio is selected for HDMI input in this unit’s settings (p.62).

( Audio is not included in the video signal output to the computer. The audio needs to be brought in
separately as USB audio. Select “HDMI” for the mixer input (p.106), and set up a patch (p.59) for USB
MAIN (A/B/C) in the USB menu of Output Patch.
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Settings for video input to your computer (for video
models)

Select [Yamaha MGX/URX Video] as the video input for your computer’s application (app). There is no need to
configure any settings on this product.

NOTE
( If the HDMI input is protected by HDCP, you will not be able to capture audio or video.
( If you are able to disable HDCP on your HDMI source device, you should disable it. You may also be able to resolve the problem by

disabling HDCP on this product (p.62).

n About HDMI

The MGX16V and MGX12V support HDMI signal input up to 4K/60 Hz (PCM 8 ch, 192 kHz/24-bit audio).
( HDMI IN: Video is up to 4K/60 Hz, and audio is up to 8 ch/192 kHz/24-bit. Note that the signal is down-

mixed in this unit to 2 ch, and is resampled to match the sampling frequency of the unit.
( HDMI THRU: Note that if multi-channel audio for the HDMI input is turned on in this unit’s settings, audio

will not be output from the HDMI THRU connector.

NOTE
( The HDMI signal cannot be passed through while this product is in standby mode.
( This product does not support ARC/eARC.
( Use an HDMI cable (19-pin) that features the HDMI logo when connecting your devices. We recommend that you use a short cable

to prevent signal quality degradation.
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Overview of the screen and basic operations
Overview of the screen

The display screen on the top panel is mainly divided into four areas. Touch the screen to select, or use the
knobs to make the corresponding detailed settings or access the function screens.

a

c

d

b
a Toolbar

The icons let you access frequently used functions and system setting screens. The toolbar is always shown, even if
you switch the main area display. (The number of icons changes depending on which screen is shown.)

b Main area
Shows the contents that are appropriate for the screen or channel you select.

c Side menu
Switches between menus that are shown in the main area.

d Multi-function knob toggle button
Switches the USER DEFINED KNOBS mode on/off (p.35).
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Basic screen operations

n Direct operation by touch

Touch the icon buttons or menus on the toolbar to directly switch between screens.

NOTE
( On screens that are divided into multiple pages, touch the arrow buttons on either side to move between pages.

( You can touch the handles on the graph to operate them directly.

Handles

n [TOUCH AND TURN] knob

Touch the parameters on screen that you want to operate, and use the [TOUCH AND TURN] knob to quickly
control them. A pink border appears around the parameter when you touch it.

Value control
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Press the knob during EQ operations to switch between Gain or Freq.

Direct control is possible

n Operating with the multi-function knobs

The multi-function knobs let you directly operate four major parameters onscreen.

If many parameters are shown, touch [<] or [>] to switch between the target parameters.

When USER DEFINED KNOBS mode is on, you can control the value of the parameter you set. Touch [<] or [>]
to switch between the four banks (1–4) of the USER DEFINED KNOBS. The selected bank number is outlined
in the illustration below.

For the parameter settings in USER DEFINED KNOBS mode, see the [SETUP] screen → [top menu] → [User
Defined Knobs] menu (p.56).
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NOTE
The parameter you are controlling with the multi-function knobs is given focus in light purple.

n Onscreen user interface

Buttons
Use the buttons to execute specific functions, toggle parameters on/off, and make selection from a list of
options. The color of the buttons used for toggling on/off shows up more prominently when the button is on,
and is fainter when the button is off.

Shows a separate popup screen for making detailed settings.

Shows a pulldown menu.

Returns to the previous screen.

Returns to the home screen. If you touch this when on the HOME screen, this shows the channel
view for the selected channel.

List screens
A screen like the one shown below appears when you select items from a list, such as the USER DEFINED
KNOBS settings screen.
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The items outlined in pink in the list are targeted (selected) for operation. Use the [TOUCH AND TURN] knob
to scroll up and down within a list.

Dialog box
A dialog box like the one shown below appears when you need to confirm something about the operation
you just executed. Touch [OK] to execute the operation. Touch [Cancel] to cancel the operation.

Scrolling
On screens with scroll bars, scrolling the screen up/down or left/right shows the following screen.
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Operation mode
Operation mode settings

This product features two types of Operation Mode. The functions that can be used in Simple Mode are
designed according to preset use cases. This mode lets you make settings by following along with the
tutorial, operating the unit with a simple user interface. Standard Mode gives you access to all of the
functions.

NOTE
( The Operation Mode selection screen is shown after the language selection and date/time setting screen the first time you turn on

the power. On the screen that’s shown, choose either Simple Mode or Standard Mode.
( If you turn off the unit without selecting a mode, the Overview screen for Standard Mode is automatically shown the next time you

turn on the unit.

n How to set the operation mode

1 Touch [ ] in the toolbar to display the SETUP screen.

2 Touch [Operation Mode (Simple/Standard)] at the top left of the screen.
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3 Select either “Simple Mode” or “Standard Mode”.

n Settings when switching between operation modes
( Simple Mode→Standard Mode

The settings you make while operating in Simple Mode are carried over as-is to Standard Mode.
( Standard Mode→Simple Mode

The settings you make in Standard Mode are discarded and reinitialized for Simple Mode.
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Simple mode
Simple Mode features functions that can be set easily, for settings that correspond to a variety of use cases.

Simply follow the onscreen instructions of the setup assistant to select the operating mode and configure
the necessary settings, for easy use of the MGX series.

Automatic level adjustment function
Touch the [Auto] button to automatically adjust the input level. During adjustment, you should talk, sing and
play at the actual volume you will use.

The input level will be set to the optimum setting once automatic adjustment is completed.

For details on Simple Mode, refer to the “Simple mode operation guide” (p.124).
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Standard mode
Standard Mode lets you use all of the functions.

The screen layout in this guide and so forth are explained in Standard Mode (p.43).

See each section for details on the necessary operations.

42

Operation mode > Standard mode



HOME screen (Overview)
Screen layout

This is the main screen for this product in Standard Mode. This screen is shown when you start up this unit.

When a different screen is shown, touch  in the toolbar to return to this screen. When this screen is

shown, touch the  button to show the channel view of the selected channel.

Toolbar

Side menu

Main area
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Toolbar

a b c d e f g

a Shows the [SCENE] screen. (p.74)

b Selects the channel bank that’s shown in the main area. (p.45)

c Shows the [SOUND PAD] screen. (p.78)

d Shows the [SETUP] screen. (p.51)

e Shows the [microSD] screen. /  is shown when the microSD is playing back or recording
data. (p.84)

f Shows the [MONITOR] screen. (p.68)

g Shows the [HOME] screen. (p.43)
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Main area

Channel view
Touch the parts of the channel that are shown in the main area to select them. The selected channel is given
focus with a white border. Touching the yellow border displays the channel view (p.95).

Channel bank
Four channels are shown at once in the main area. A group of channels shown at once is called a channel
bank.

Switching between channel banks
You can switch between channel banks using the following methods.
( Touching the channel bank selection button on the toolbar
( Swiping left or right in the main area

NOTE
You can’t switch between input and output channel banks by swiping left/right.
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Channel view variations

MONO IN channel ST IN channel PAD channel FX channel

STEREO channel MIX channel STREAMING channel

NOTE
Selecting the channel by operating the screen works in tandem with the top panel [SEL] keys. The [SEL] key actions when working in
tandem are as follows.
( The indicator of the [SEL] key on the top panel that corresponds to the channel selected by operating the screen lights up.
( When you press a [SEL] key on the top panel, the channel bank shown in the main area moves to the channel bank that includes

the channel in question.
( When selecting MIX1–MIX8 or the STREAMING channel, all of the [SEL] keys on the top panel go dark, as there is no corresponding

channel on the top panel.

46

HOME screen (Overview) > Main area



Channel display when used as a stereo pair (V1.2 and later)

When you select STEREO from Signal Type on the “Channel settings screen” (p.97), a heart symbol (♡)
appears between the PAN slider for the odd- and even-numbered channels. The channels in question are the
MONO IN channel and MIX channel.
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Channel area

a

b

f

g

d e

c

a Channel name area
Shows the channel icon, channel ID and channel name.

NOTE
For an ST IN channel, you can touch the channel name area to toggle the channel (L/R) for which you want to display the information
in the b indicator area. Unselected channels are shown in black letters.

b Channel indicator area
Shows the input signal level for the channel, as well as various settings. For details, refer to the “Dedicated channel
screen ” (p.105) section. When you tap this while a channel is selected, the channel view is shown.

c Channel meter
This is a level indicator with a range of -60 dB to 0 dB.

Stereo channels are shown with a stereo meter.

d [ON] button
Toggles the channel on/off. This lights up when the channel is on.
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e [CUE] button
Toggles CUE on/off for the channel. This lights up when CUE is on.

f PAN/BALANCE slider
Shows either the PAN or the BALANCE setting for the channel.

g Send level knob
This is operated by the multi-function knob below the display. You can adjust the send level by turning the knob.
When the [Sends] button setting in the side menu is “ST(STEREO)”, only the faders on the top panel can be operated.

NOTE
When USER DEFINED KNOBS mode is on for the multi-function knobs, the send level knob can’t be operated.
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Side menu

a

b

c

a [Sends] button
Selects the send destination for the channel that’s shown in the main area. The send destination selection menu is
shown when you touch this button. The level for the send destination you select here can be adjusted using the
[SEND] knob on the top panel.

b STEREO/CUE meter
Shows the post-fader level for the STEREO out channel. When CUE is on, the CUE bus level is shown. When you touch
the meter area, all CUE turn off (CLEAR CUE function), and the display returns to the STEREO out channel view.

STEREO meter CUE meter

c Multi-function knob toggle button
Switches the USER DEFINED KNOBS mode on/off.

When USER DEFINED KNOB is off

When USER DEFINED KNOB is on
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SETUP screen
Top menu

GENERAL menu

This is the top menu that’s shown when you touch  in the toolbar. You can touch the respective buttons
to access the version screen, license screen and the various settings screens.

(V1.2 and later)
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Version menu
Shows the version information for the system software.
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License menu
Shows the LICENSE screen, which shows the license information for the system software. Use the [TOUCH
AND TURN] knob to scroll the view.
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Language menu
This lets you select the language that’s displayed.
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Brightness menu
This sets the brightness for the display and panel.

a b

a Screen
Sets the brightness for the display (LCD screen).

b Panel
Sets the LED indicator brightness for the top panel.
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User Defined Knobs menu
This screen is for configuring the USER DEFINED knobs. Banks 1–4 are provided, and you can assign the
functions you select to the A–D knobs.

a

b

c

a [Bank] 1–4
Selects the bank for which you will make the settings.

b [USER DEFINED KNOBS] A–D
Shows the parameter that’s set. The settings menu screen is shown when you touch these knobs.

c [USER DEFINED KNOBS] display text
When the USER DEFINED KNOBS function is on, an abbreviated text label is shown at the lower part of the screen.
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User Defined Keys menu
Sets the USER DEFINED KEYS for the top panel. Banks A–D are provided, and you can assign the functions
you select to the 1–8 buttons.

a

b

a [Bank] A–D
Selects the bank for which you will make the settings.

b [USER DEFINED KEYS] 1–8
Shows the parameter that’s set. The settings menu screen is shown when you touch these knobs.
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Sampling Frequency menu

a

b

a [44.1kHz, 48kHz, 88.2kHz, 96kHz] buttons
Use these buttons to select the sampling frequency for the mixer and the signal processing.

b [Follow USB] button
When this is on, the sampling frequency setting matches that of the computer connected to the USB MAIN port.
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Output Patch menu

n OMNI OUT menu

This menu is used to configure the settings for the signals outputted from the OMNI OUT output connector/
port.

b

a

a Output source selection buttons
The output source selection popup menu is shown when you touch these buttons. Select the source from the screen
that’s shown.

List of sources to select

b [Default] button
Resets the patch settings. When you touch this button and tap [OK] on the dialog box that’s shown, the settings are
reset.
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n USB menu

This menu is used to configure the settings for the signals outputted from the USB output connectors/ports.

b

a

a Output source selection buttons
The output source selection popup menu is shown when you touch these buttons. Select the source from the screen
that’s shown.

List of sources to select

CH 13/14, CH15/16 are not available on the MGX12V and MGX12.

b [Default] button
Resets the patch settings. When you touch this button and tap [OK] on the dialog box that’s shown, the settings are
reset.

NOTE
(MGX16V, MGX12V)

For purposes of copyright protection, audio that is protected by HDCP cannot be output via USB. Select “HDMI” for the input source of
either input channel to output the HDMI audio to all output channels. If the HDMI input signal is HDCP-protected, the audio sent to
USB from these channels is automatically muted.
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n STEREO menu (V1.2 and later)

This menu is used to set the signal that’s output from the STEREO OUT connectors.

a b

a Output source selection buttons
The output source selection popup menu is shown when you touch these buttons. Select the source from the screen
that’s shown.

List of sources to select

b [Default] button
Resets the patch settings. When you touch this button and tap [OK] on the dialog box that’s shown, the settings are
reset.
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Peripheral menu

n USB Main menu

This is for configuring the USB port settings.

a

a [Generic Driver Audio Channel Suppression]
This configures input/output channel restrictions when connecting using standard drivers on devices like the iPad/
iPhone.
( [None]: no restriction
( [2 Channels]: The channels are restricted to 2 IN/2 OUT.

Select [2 Channels] when using this unit with apps that only support 2 IN/2 OUT audio streams.
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n Bluetooth menu

Configures the Bluetooth settings.

a b c d

a [Enable] button
This button enables Bluetooth. When this is off, the items listed below cannot be set.

b [Pairing] button
Configures the pairing with devices that transmit Bluetooth audio signals.

Touch the button to start pairing. The button automatically turns off when pairing is completed.

c [Status] display text box
When a Bluetooth connection is established, the name of the other device is shown in this text box.

d [Disconnect] button
Disconnects the device’s connection.
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n HDMI menu (only for video models)

This is for configuring the HDMI settings.

a b

a HDCP [Enable] button
Use this to enable/disable HDCP (High-bandwidth Digital Content Protection) on this product. HDCP is enabled when
the button is on, and disabled when the button is off.

b [Input Audio Channels]
Sets the number of HDMI audio input channels and the corresponding sampling frequency.
( [2 Channels]: always two channels (48 kHz max.)
( [Multi Channels]: supports up to 192 kHz/8 channels

The signals are down-mixed in the mixer to stereo (two channels), even when multi-channel input is used.
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Power Management menu

n Auto Power Off menu

This feature automatically turns off the power if the unit has not been operated for a specified length of time.

a b

a [Enable] button
Turns on the auto power off function.

b [Time] knob
Touch near the knob or text to give the control focus. Use the [TOUCH AND TURN] knob to specify the time required
from the time the unit is last operated until power off (non-operational time). This can be set within the range of 2–20
minutes in one-minute increments (the default setting is 20 minutes).

NOTE
Turning off (disabling) the auto power off function keeps the device powered on continuously, which will increase power
consumption.
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Date/Time menu
This menu is for setting the date and time of this unit.

c d

a

b

a [Date/Time] popup button
Set the date and time on the screen that appears. Touch the item you want to change and operate the [TOUCH AND
TURN] knob. When you’ve finished making the settings, touch the [OK] button to apply the settings and close the
popup window. To close the popup window without applying the settings, touch the [Cancel] button.

b [Time Zone] popup button
Selects the name of the city representing the time zone on the screen that’s shown.

c [Display Format] Date button
Selects the display format for the date.

d [Display Format] Time button
Selects the display format for the time.
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Software Integration menu (V1.2 and later)
This menu is shown when you connect your computer and launch the compatible software (Steinberg
Cubase, Nuendo, MixKey). For details on software integration, see “Using the Software Integration functions
(V1.2 and later)” (p.169).

n DAW Integration menu

a

a [Post Fader Send for FX] select button
Selects the MIX bus to send to FX1 and FX2. The send point is post-fader.
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MONITOR screen
Top menu

This menu is for operating the signal used to check headphones or near-field monitors. It allows you to select
the source to be continuously monitored, to change the monitor signal to mono and to operate the CUE
function and so forth.
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Monitor menu
This menu is for selecting the [MONITOR] 1–4 source, for setting the volume and other parameters.

n Level

This shows the MONITOR volume operation parameters.

a

b

c

a Level meter
Shows the monitor output level.

b [ON] button
Switches each monitor output on/off.

c [Level adjustment knob/text box]
Operate by using the [TOUCH AND TURN] knob or the multi-function knob.
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n Setting

This is for selecting the monitor source and configuring the CUE signal.

a

b

c

a Monitor source selection button
The settings screen is shown when you touch this screen. You can select the monitor source from the screen that’s
shown. The screen closes automatically after selection.

b [CUE Interrupt] button
Switches the function for interrupting the [CUE] signal to the monitor on/off. When this is on, turning the CUE on
replaces the monitor output signal with the CUE signal. When this is off, the signal selected with the a monitor
source selection button is always output.

c [MONO] button
Switches the function on/off for converting the signal output to the monitor to monaural.

NOTE
The MONITOR 1–4 signals are output to PHONES 1–4. When outputting from the OUTPUT connectors, configure the settings in the
“Output Patch menu” (p.59).
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Phones menu
This menu is for setting the [PHONES] 1–4 volume.

a

a Level adjustment knob/text box
Adjust the level of signal output from the [PHONES] connectors using the multi-function knobs.

NOTE
The signals output from [PHONES] 1–4 are the same as the signals set for [MONITOR] 1–4. Only the signal levels can be operated
independently (p.69).
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Oscillator menu

n OSC

This menu is for configuring the oscillator.

a

b

c

d e f

a [Oscillator Mode]
This selects the type of oscillator used for output.
( Sine Wave: Outputs a sine wave.
( Pink Noise: Outputs pink noise.
( Burst Noise: Cyclically outputs short bursts of pink noise.

b [ON] button
Switches the oscillator on/off.

c [Level]
Sets the oscillator output level. Operate by using the [TOUCH AND TURN] knob or the multi-function knob.
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d [Frequency]
This is shown when the oscillator mode is [Sine Wave]. Sets the sine wave frequency. Operate by using the [TOUCH
AND TURN] knob or the multi-function knob.

e [Width]
This is shown when the oscillator mode is [Burst Noise]. Sets the length of noise. Operate by using the [TOUCH AND
TURN] knob or the multi-function knob.

f [Interval]
This is shown when the oscillator mode is [Burst Noise]. Sets the noise cycle. Operate by using the [TOUCH AND
TURN] knob or the multi-function knob.

n Assign

This sets the oscillator output for each bus.

a b

a Output bus assignment buttons
Switches the oscillator output to each bus on/off.

b [Clear All] button
Turns off all bus assignments.
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SCENE screen
Top menu
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Scene List menu

n Store/Recall

This screen is for managing the scenes you’ve saved that contain the mixer settings.

a

b

c

d

e

a Current scene indication
Shows the currently selected scene number and name.

NOTE
If the selected scene number is different from the last scene number you recalled, the number flashes.

b List bank selection
Switches between Scene List banks. Scenes are listed separately for each Operation Mode setting.

NOTE
You can’t operate the Standard bank list when Operation Mode is set to Simple Mode.
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c Scene list
Shows the scenes that are saved.

No.
Shows the scene number (01–63). [r] is shown for the last recalled scene.

Title
Shows the title name.

Lock
Shows the protect status. Scenes for which the protect setting is on cannot be overwritten.

: factory reset

: file for which the protect setting is on.

NOTE
The scene numbers are the same for Standard Mode and Simple Mode. You can’t register a scene with the same number. For example,
if you register scene number [03] in Standard Mode, [03] does not show up in the list for Simple Mode.

d [Store] button
Stores (saves) the current settings in the number that’s selected in the list.

e [Recall] button
Recalls (loads) the selected scene.

n Edit

cba

a [Protect] button
Toggles the protect function (write prevention) for the selected scene on/off.

b [Delete] button
Deletes the selected scene.
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c [Title] button
Edits the title name of the selected scene.

NOTE
In Standard Mode, you can refer to and recall the scene list from Simple Mode, but you can’t store (save) or edit (protect, delete, edit)
it.

n Settings that are saved in a scene

The settings saved to the scenes mainly include the mixer channel settings. The following settings are not
saved.
( Settings for the SETUP screen, MONITOR screen, SOUND PAD screen, microSD screen andSTREAMING

channel
( Channel levels for CH1–CH16 (or CH12), PAD, FX1–2, and STEREO channel, which can be operated from the

faders on the top panel

In Simple Mode, both the Output Patch and Monitor settings are saved as necessary.
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SOUND PAD screen
Top menu

You can assign and play back audio files assigned to the eight buttons of the sound pad. These can be used
for playing jingles or sound effects to match the situation.
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Pad Play menu
This menu is for configuring the playback operations for each PAD, and for setting the playback volume.

a b

a PAD playback button
Touch this to play back the audio that’s registered to the [PAD].

The color of the button’s border is the color that’s set for [Color] in the [Pad Setting] menu. The button shows the PAD
number (1–8) in the upper left, the PAD name in the center, and the PAD audio data sampling frequency in the lower
right. If the sampling frequency differs from that of this product, the [!] mark is shown.

NOTE
The playback method can be changed from [Playback Mode] in the [Pad Setting] menu (p.80).

b Meter
Shows the playback volume.
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Pad Setting menu

a

b

d

e

f

c

a PAD setting button
The settings menu screen is shown when you touch these buttons.

b PAD button and meter
Plays back the audio that’s registered to the [PAD]. The volume meter is shown during playback.

c [Color]
Selects the color for the [PAD] button.

80

SOUND PAD screen > Pad Setting menu



d [Name]
Sets the name that’s shown on the PAD button. Use the text input screen to set the name.

e [Playback Mode]
Selects the playback mode for the PAD button.
( [One Shot]: Each time you touch this button, the data plays back once from the beginning.
( [Hold]: The data plays back repeatedly while you are touching this button. Release your finger from the button to

stop.
( [Loop]: The data plays back repeatedly when you touch this button. Touch the button again to stop.

f Parameter knobs
( [Level]: Sets the volume for each pad.
( [FX1 Send]: Sets the amount of signal to send to FX1 from each pad.
( [FX2 Send]: Sets the amount of signal to send to FX2 from each pad.
( [Pan]: Sets the stereo position for each pad.
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Pad Record menu
This menu is for recording audio to each pad. See “Recording to the sound pads” (p.159) for how to record.

a

e

c
b

f
g

d

h

a PAD recording button
Touch these buttons to show the recording menu screen.

b PAD button and meter
Plays back the audio that’s registered to the [PAD]. The volume meter is shown during playback. Shows the recording
volume during recording.

c [Cancel] button
Discards the data you’ve recorded, and returns to the original data.

d [Apply] button
Saves the data you’ve recorded.

e Progress bar
Shows the recording progress.

f  (Stop) button
Stops the recording.
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g  (Play) button
Starts the recording.

h  (Rec) button
Enters record standby mode. The button lights up when recording starts.
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microSD screen
Top menu

This menu is for setting the microSD card that’s inserted in this product.

(V1.2 and later)

n SD cards compatible with this product

microSD cards can be used on the MGX Series. Use an SDXC microSD memory card or an SDHC memory card
that fulfills the following performance characteristics.
( Cards with a UHS-I bus interface or greater, which operates under SDR104 bus speeds
( UHS speed class 1 or greater
( Speed class 10 or greater

NOTE
( Media with fast and stable write speeds is required for multitrack recording.
( The write speed of SD cards decreases as the media is used repeatedly. Format your media on this product before making any

important recordings.
( You can improve recording stability by limiting the number of tracks that are recorded (p.87).
( Use the Test function (p.92) to get an idea of the performance specs of your media.

You may not be able to record or play back correctly with some microSD cards.

For the latest information on compatible products, see the following Yamaha website.

https://www.yamaha.com/2/mgx/

n Handling SD cards
( Be careful of the front/back orientation and the direction when inserting a microSD card, and insert the

card all the way. Do not force the card in.

( To remove a microSD card, touch  and follow the directions indicated in the dialog box. If “Now you
may safely remove the microSD card.” is displayed, gently push in on the microSD card. When it pops out a
little, pull out the card.
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n Formatting (initializing)

You will need to format (initialize) your microSD card if you are using it for the first time or if the card uses an
unsupported file system.

If you see a dialog box asking you to format the media, touch [OK] to format. Formatting requires time. It
takes about three minutes to format a 128 GB microSD card.

NOTICE
( It may take time for the card to be recognized, depending on the microSD card.
( All data will be completely erased from the microSD card once you format (initialize) it. If the card contains data that you need,

back the data up beforehand to your computer, and then format the card.
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USB Storage Mode button (V1.2 and later)

When the USB Storage Mode button is on (lit up light blue), the microSD card is recognized as a drive by the
computer, and you can use it to read and write files. The files can be accessed by a computer that’s
connected to the [USB MAIN] connector.

NOTE
You cannot access any other menus from this product while USB Storage Mode is on.
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RECORDER menu

n Record

Sets the recording source for recording to the microSD card.

a

b

c

e

g

d

f

a [Track Count]
Select the number of tracks to record using the pulldown menu that’s shown, in groups of two tracks.

b [Source] select button
Touch this button to select the recording source from the screen that’s shown.
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NOTE
(MGX16V, MGX12V)

For purposes of copyright protection, audio that is protected by HDCP cannot be recorded to an SD card. Select “HDMI” for the input
source of either input channel to output the HDMI audio to all output channels. If the HDMI input signal is HDCP-protected, the audio
sent to the SD card from these channels is automatically muted.

c Record source meter
Shows the recording source level.

d Sampling frequency
Shows the sampling frequency during recording (only while recording).

e Counter
Shows the recording time.

f Progress bar
Shows the remaining free space on the microSD card.

g Buttons used for recording

 [REC]: Sets or cancels record standby.

 [Play/Pause]: Starts/pauses the recording.

 [Stop]: Ends the recording.

NOTE
Multitrack audio files that contain more than two tracks cannot be played back on this product. Copy the files to your
computer and load them into your DAW or other software.
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n Play

This menu is for selecting the recorded data or a file that supports playback, and operating the playback
features.

d

a b c

f

eg h i j

a
[ ] button
Moves to the topmost folder in the folder architecture on your microSD card.

b Folder name display
Shows the path from the root directory to the current folder. If the path name doesn’t fit in the display, it is shown
from the end.

c Volume name/capacity display
Shows the name of the microSD card and the remaining free space.

d List of files that can be played back
Shows the files that can be played back in the selected folder, and the folder one level below.

List icons

: Folder one level below

: Audio file that can be played back

: Audio file now playing

NOTE
( The number of the files in a folder should be limited to 128.
( Files can be played back if they meet the following conditions.

( 32-bit, 24-bit, and 16-bit stereo linear PCM audio files in WAV format
( Files with the same sampling frequency as used on this product
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e Meter
Shows the meter in stereo for the audio that’s playing back.

f
[ ] button
Touch this button to move the cursor to the file that’s playing back.

g Sampling frequency display
Shows the sampling frequency during playback (only while playing back).

h Counter
Shows the playback time.

i Progress bar
Gives a visual indication of the playback time for the file that’s now playing back.

j Buttons used for playback
The buttons start, pause and otherwise control the playback.

 [Stop]
Stops the playback of the file.

 [Pause]
Starts/pauses the playback.

NOTE
To play another file while one is currently playing, first stop playback using the [Stop] button, then start playback using the
[Play/Pause] button.
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n Edit

This screen is for editing the filenames on the microSD card and for deleting files.

d

a b c

fe

a
[ ] button
Moves to the topmost folder in the folder architecture on your microSD card.

b Folder name display
Shows the path from the root directory to the current folder. If the path name doesn’t fit in the display, it is shown
from the end.

c Volume name/capacity display
Shows the name of the microSD card and the remaining free space.

d List of files that can be played back
Shows the files that can be played back in the selected folder, and the folder one level below.

List icons

: Folder one level below

: Audio file that can be played back

4tr–16tr: Number of audio file tracks recorded on this product

44.1 kHz, 48 kHz: 4tr, 6tr, 8tr, 10tr, 12tr, 14tr, 16tr

88.2 kHz, 96 kHz: 4tr, 6tr, 8tr

e
[ ] button
Deletes the selected file.

f
[ ] button
Edits the selected filename.
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TOOLS menu

n Format

Formats (initializes) the microSD card.

a b

a [Format microSD] button
Once you input a volume label and touch the [OK] button, the formatting of the microSD card is executed.

b Volume name/capacity display
Shows the name of the microSD card and the remaining free space.
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n Test

Evaluates the write speed of the microSD card.

a

a [Test microSD] button
Touch this button to begin the analysis. The result is shown after about 10 seconds.

c

d
e

b

b [Result]
A general evaluation rating is given, either [A], [B], [C] or [NG] (no good).

[A] rating (green): both Multi Tracks and 2 Tracks can be recorded, and all Card specs are Pass

[B] rating (yellow): Multi Tracks recording is possible if the frequency is selected, and all Card specs are Pass

[C] rating (orange): 2 Tracks recording is possible if the frequency is selected, and all Card specs are Pass

An [NG] rating is assigned in all other cases.

c [Card specs]
Determines whether there are any problems with the specifications of the card, and gives a [Pass] or [Fail] rating.

This displays the specifications of the interface or speed class, which are displayed in red if the specs are not met.
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d [2 Tracks Recording]
A write test is performed, and the maximum sampling rate at which two-track recording can be done without
problems is shown.

The evaluation results are shown as follows.
( Green: two-track recording can be done at any frequency
( Yellow: recording can be done if the sampling frequency is equal to or higher than the current sampling frequency

of this unit
( Red: recording can be done only at sampling frequencies that are lower than the current sampling frequency of

this unit
( [Fail] (red): recording cannot be done at any frequency

Example: when the setting on this unit is 48 kHz

[Max 96kHz] (green): recording at 44.1 kHz, 48 kHz, 88.2 kHz or 96 kHz is supported

[Max 88.2kHz] (yellow): recording at 44.1 kHz, 48 kHz or 88.2 kHz is supported; 96 kHz is unsupported

[Max 48kHz] (yellow): recording at 44.1 kHz, 48 kHz is supported; 88.2 kHz and 96 kHz are unsupported

[Max 44.1kHz] (red): recording at 44.1 kHz is supported; 48 kHz, 88.2 kHz and 96 kHz are unsupported

[Fail] (red): recording cannot be done at any frequency

e [Multi Tracks Recording]
A write test is performed, and the maximum sampling rate at which multitrack recording can be done without
problems is shown.

If [Max 96kHz] is shown in green, the write speed allows for 48 kHz/16-track and 96 kHz/8-track recording. If the
conditions are not met, [Fail] is shown in red.
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Channel view
Screen layout

Main area

Toolbar

( The main area screen display changes according to each channel.
( A summary of the parameters for the selected channel is shown in the main area. The items that are

shown will change depending on the selected channel.
( Touch each object in the main area to target the relevant parameter for operation. Touch them again to

switch to a details screen for the function in question.
( For details on each function, refer to “Dedicated channel screen ” (p.105).
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Toolbar

a b a

a Channel selection buttons
Touch [<] to switch to the previous channel, and [>] to switch to the next channel. The channel selection loops from
CH1 to STREAMING, or from STREAMING to CH1.

b Channel settings screen display button
The channel settings screen is shown when you touch this button. Refer to the next page for more on the channel
settings screen.

96

Channel view > Toolbar



Channel settings screen

a

d e

b c

NOTE
The items shown differ depending on the channel.

a [Color]
Selects the channel color.

b [Icon]
Selects the channel icon. Scroll through the icon list to make a selection.

c [Name]
Input the channel room name. The text input screen is shown when you touch this button.

d [Rec Point]
This lets you select the point within the signal path from which to directly record the signal of a channel.

e [COMP/EQ]
You can select whether to use the channel’s COMP/EQ as a COMP -> EQ or as an SSMCS (Sweet Spot Morphing
Channel Strip).
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f g h

f [BUS Type]
You can select the bus type for two adjacent MIX buses (MIX1/2, MIX3/4, etc.). Select either VARI (variable send level)
or FIXED (fixed send level) for the bus type.

g [Signal Type]
You can select the operation mode for two adjacent channels (CH1/ 2, CH3/4, MIX1/2, MIX3/4, etc.). Select from either
stereo link (STEREO) or two independent channels (MONO × 2).

NOTE
(V1.2 and later)

When you select STEREO for the MONO IN channel, a button is shown that lets you select between PAN and BAL (balance). You can
select whether to use the respective channels as PAN or as L/R balance.

h [Pan Link]
You can configure a function that links the send pan settings from the send source channel to the channel PAN. This
function is enabled when the signal type is STEREO and the bus type is VARI. Touch the button to switch between
PAN settings.
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Main area

e

f

g

h

a b c d

a Input area
This area includes the input gain, input meter, [+48V] indicator, [φ] indicator, [HPF] indicator, [AUTO] button, [SAFE]
button and so forth.

The items that are shown differ depending on the selected channel.
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MONO IN channel

MIC/LINE  input is selected as the input
source

LINE  input (phone connector) is
selected as the input source

Another input besides those listed at
left is selected as the input source

ST IN channel

MIC/LINE  input is selected as the input
source

LINE  input (phone connector) is
selected as the input source

Another input besides those listed at
left is selected as the input source

n Explanation of the indicator buttons

The items that are shown differ depending on the selected channel. Here we explain some of these items. For
a description of other indicators and buttons, refer to “INPUT screen” (p.106) in “Dedicated Channel
screens.”
( LOW, HIGH: When the LINE  input (phone connector) is selected as the input source, LOW (low) and HIGH

(high) are shown for the gain.
( AUTO: This is the auto-gain button. Touch this from the off position to turn it on and start the auto-gain

settings. When the correct input gain is determined, it is reflected in the analog input setting value, and
the button automatically turns off.

( SAFE: This is the clip safe button. When this is on, the gain is automatically lowered to avoid clipping when
excessive input is detected. The button color changes from light blue to orange when the gain is
automatically lowered.
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b GATE area (MONO IN channel only)

Touch the GATE button to switch the gate on/off. Use the [TOUCH AND TURN] knob to set the threshold. Touch within
the area to open the [GATE] screen.

The lower indicators show the open/close status of the GATE.

 GATE is completely closed (gain reduction is at or below the RANGE)

 GATE is in the middle of opening or closing (gain reduction is equal to or greater than RANGE, but less than
0 dB)

 GATE is completely open (gain reduction is 0 dB)

 GATE is off

c COMP area (MONO IN channel only)
Touch the COMP button to switch the compressor on/off. The parameters you can operate with the [TOUCH AND
TURN] knob differ depending on whether 1-knob mode is on or off. When it is off, you can set the threshold. When it is
on, you can set the effect depth within 0–100%. Touch within the area to open the [COMP] screen. For the lower
indicators, the top indicator shows the input level, and the bottom indicator shows the gain reduction.

NOTE
About the 1-knob function

When you turn 1-knob on, you can easily operate multiple parameters with the [TOUCH AND TURN] knob. When 1-knob is on, the
parameters cannot be operated individually. You can set 1-knob on/off in the dedicated channel screen.
( When 1-knob is off

Touching anything else besides the [COMP] button gives it focus with a pink border. Operate the [TOUCH AND TURN] knob to set
the threshold.

( When 1-knob is on

Operate the [TOUCH AND TURN] knob to set the value. Touch within the area to display the [COMP] screen.
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d EQ area
Touch the EQ button to switch the EQ on/off. When 1-knob mode is on, you can use the [TOUCH AND TURN] knob to
set the effect depth within 0–100%. The graph below shows the EQ frequency characteristics. Touch within the area
to open the [EQ] screen.

When 1-knob mode is off When 1-knob mode is on

e SSMCS area (MONO IN channel only)
When the [COMP/EQ] TYPE is SSMCS, the COMP area and EQ area are swapped. Touch the SSMCS button to switch
the SSMCS on/off. Touch within the area to display the [SSMCS] screen.

NOTE
( SSMCS (Sweet Spot Morphing Channel Strip) is a function built into Yamaha USB audio interfaces, which lets you adjust the EQ and

compressor to the optimum balance using a single knob.
( You can change the [COMP/EQ] TYPE in the “Channel settings screen” (p.97) screen of channel view.

f INS FX area
Touch the INS FX button to switch it on/off. If no effect is inserted, [No Effect] is shown. Touch within the area to
display the [INS FX] screen.

g PAN/LEVEL area
Shows the channel ON, CUE, PAN settings and the LEVEL meter for the channel.

[PAN] knob/BALANCE knob
Shows the stereo position of the signal.
You can set the PAN/BALANCE by using the [TOUCH AND TURN] knob or the multi-function knob. [C] indicates the
nominal (center) position.

NOTE
(V1.2 and later)

When you select STEREO for Signal Type (p.97) and select [BAL] from the PAN/BAL button that’s shown, the BALANCE knob can be
displayed in the MONO IN channel.
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[LEVEL] knob
Shows the level for the channel. Adjust this using the fader on the top panel. This cannot be adjusted from the screen.

[CUE] button
Toggles CUE on/off for the channel. This lights up when CUE is on.

[ON] button
Toggles the channel on/off. This lights up when the channel is on.

LEVEL meter
This is a level indicator with a range of -60 dB to 0 dB.
Stereo channels and channels that are stereo-linked are shown with a stereo meter.

h SEND TO button
Touch this button to switch to the [SEND TO] screen.

i DUCKER area (ST IN channel only)

Touch the DUCKER button to switch it on/off. Use the [TOUCH AND TURN] knob to set the threshold. Touch within the
area to display the [DUCKER] screen.

The lower indicators show the operational status of the DUCKER.

 DUCKER is completely attenuated (gain reduction is at or below the RANGE)

 DUCKER is in the middle of attenuating (gain reduction is equal to or greater than RANGE, but less than 0
dB)

 DUCKER is not operating (gain reduction is 0 dB)

 DUCKER is off
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j DELAY area (only STREAMING channel)

Touch the DELAY button to switch it on/off.

Use the [TOUCH AND TURN] knob to set the delay time. Touch within the area to display the [DELAY] screen.
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Dedicated channel screen
Channel settings screen

This screen is for configuring the detailed settings for the module of each channel.

b c d ea

Common buttons for each screen
a Channel selection buttons

Touch [<] to switch to the previous channel, and [>] to switch to the next channel.

b Channel name display area
Shows the selected channel name.

c Module on/off button
Shows the module name. Also, when the following functions are selected, this switches the module on/off. When you
click to turn this off (displays in gray), the function is disabled.

GATE, COMP, EQ, SSMCS, INS FX, DUCKER, DELAY

d
 button

Returns to the channel view display.

e  button
Shows the HOME screen.
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INPUT screen

c d e f g h i j k

a b

a [Input Source] select button
Shows the input source selection popup menu. When you select an input source, you can select the input level. For
monaural input channels, this sets two adjacent channels as a group.

For CH 9/10 on the MGX16V and MGX16 (only MGX16V for HDMI)

( [All Input] button: When you select “OK” on the dialog box that’s shown, the input source is set according
to the table below.
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MGX16V, MGX16

CH 1/2 CH 3/4 CH 5/6 CH 7/8

MIC/LINE  1/2 MIC/LINE  3/4 MIC/LINE  5/6 MIC/LINE  7/8

CH 9/10 CH 11/12 CH 13/14 CH 15/16

LINE  9/10 LINE  11/12 LINE  13/14 LINE  15/16

MGX12V, MGX12

CH 1/2 CH 3/4 CH 5/6

MIC/LINE  1/2 MIC/LINE  3/4 LINE  5/6

CH 7/8 CH 9/10 CH 11/12

LINE  7/8 LINE  9/10 LINE  11/12

( [All USB DAW] button: When you select “OK” on the dialog box that’s shown, the input source is set
according to the table below.

MGX16V, MGX16 (CH 1/2–CH 11/12 for MGX12V and MGX12)

CH 1/2 CH 3/4 CH 5/6 CH 7/8

USB DAW 1/2 USB DAW 3/4 USB DAW 5/6 USB DAW 7/8

CH 9/10 CH 11/12 CH 13/14 CH 15/16

USB DAW 9/10 USB DAW 11/12 USB DAW 13/14 USB DAW 15/16

NOTE
(MGX16V, MGX12V)

For purposes of copyright protection, audio that is protected by HDCP cannot be output to USB or recorded to an SD card. Select
“HDMI” for the input source of either input channel to output the HDMI audio to all output channels. If the HDMI input signal is HDCP-
protected, the audio sent to USB or the SD card from these channels is automatically muted.

b [Input Level] button
This is shown when LINE  9/10, LINE  11/12 (MGX16V, MGX16) or LINE  5/6, LINE  7/8 (MGX12V, MGX12) are selected for
the aInput Source. You can switch the input level between HIGH/LOW.

c [+48V] button
Switches the phantom power (+48V) on/off. This is shown when the MIC/ LINE  input is selected as the input source.

Precautions regarding phantom power
( Observe the following precautions in order to avoid malfunctions on this or on an external device, and to avoid noise.
( Turn this off if you don’t need phantom power.
( Turn this off if you have connected a device that does not support phantom power to the [INPUT] connectors.
( Do not plug in or unplug any cables connected to the [INPUT] connectors while this is on.
( Turn this on/off while the output volume is turned all the way down.

d [A.Gain] knob
Sets the analog gain. This is shown when the MIC/ LINE  input is selected as the input source.

NOTE
When something other than a MIC/LINE  input connector is selected, the [D.Gain] knob is shown and you can set the digital gain.
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e [Clip Safe] button
When this is on, the gain is automatically lowered to avoid clipping when excessive input is detected. The button
color changes from light blue to orange when the gain is automatically lowered. This is shown when MIC/ LINE  input
is selected as the input source.

f [Auto Gain] button
When this is on, auto gain measurements begin. When the correct input gain is determined, it is reflected in the
analog input setting value, and the button automatically turns off. This is shown when MIC/ LINE  input is selected as
the input source.

NOTE
Vocalize or make sounds while the auto gain is being measured. If the audio input is too low, an error will result and the
previous gain value is used.

g Input meter
Shows the level for the channel directly after input.

h [φ] button
Switches between φ (phase) (the phase is inverted with on, and normal when off).

i [HPF] button
Switches the [HPF] (high-pass filter) on/off.

j [HPF Freq.] knob
Sets the [HPF Freq.] (HPF frequency).

k Output meter
Shows the level of signal after passing through φ and HPF.
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GATE screen

a

b c d e f g

a [GATE] button
Switches the gate on/off.

b GATE graph
Displays the input/output response of the gate in a visual way. Directly manipulate the graph to set the threshold
level at which the effect is applied (T), and the attenuation amount when the effect is applied (R).

c [GR] (gain reduction) meter
Shows the amount of gain reduction.

d [Attack] text box
Sets the attack time.

e [Hold] text box
Sets the hold time.

f [Decay] text box
Sets the decay time.

g Input/output meter
Shows the input/output signal levels to the gate.
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COMP screen

ae d

b c f g h i

a [COMP] button
Switches the compressor on/off.

b [COMP] graph
Displays the input/output response of the compressor in a visual way. Directly manipulate the graph to set the values
for T (threshold), R (ratio), and G (gain).

c [GR] (gain reduction) meter
Shows the amount of gain reduction for the compressor.

d [1-knob] button
Switches the 1-knob function on/off.

When 1-knob is on

How 1-knob COMP works
( When 1-knob is on, you can easily control how much compression is applied with a single knob. The compression gets stronger

and the level gets higher as the 1-knob level value is increased. This evens out signals with wide volume fluctuations (where
simply raising the fader or gain would cause clipping). making the sound more prominent in the mix. This automatic control
over the balance between threshold, ratio and gain lets you use the compressor without worrying about making complicated
settings.
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e [Auto Makeup] button
Switches the Auto Makeup function on/off. When this is turned on, the appropriate gain is automatically calculated
based on the threshold and ratio settings. The calculated gain value is automatically applied.
This cannot be operated when 1-knob is on.

f [Knee] mode selector
Switches between the knee parameters (the change in volume before and after the threshold level). This cannot be
operated when 1-knob is on.

g [Attack] text box
Adjusts the attack time (how fast compression begins after the input signal exceeds the threshold level).

h [Release] text box
Adjusts the release time (how fast compression is released after the input signal exceeds the threshold level).

i Input/output meter
Shows the input/output signal levels to the compressor.
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EQ screen

ab dc

e f

a [EQ] button
Switches the EQ on/off.

b Band name display
Shows the selected band name. Touch to switch the band on/off. This cannot be operated when 1-knob is on.

c Filter selection button
Selects the filter type.

This cannot be operated when 1-knob is on.

d [1-knob] button
Switches the 1-knob function on/off.

When 1-knob is on
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How 1-knob EQ works
( When 1-knob is on, you can use a single knob to control multiple parameters at the same time. This lets you easily control

complex EQ adjustments.
When you create an EQ setting with 1-knob off and switch the 1-knob type to “Intensity”, the manual setting becomes the 50%
(midpoint) value. You can then adjust the EQ setting using the [TOUCH AND TURN] knob between 0% (no EQ applied) and 100%
(further emphasizing the manual setting). It’s convenient to use a single knob to fine-tune the EQ settings that were created
beforehand.
When the 1-knob type is changed to “Vocal” or “Loudness”, you can adjust the EQ curve between 0% (no EQ applied) and 100%
(maximum EQ applied) using the preset EQ curve.

e [EQ] graph
Drag the points in the EQ graph to control the gain/frequency characteristics. The graph cannot be operated when 1-
knob is on.

f Input/output meter
Shows the input/output signal levels to the EQ.

113

Dedicated channel screen  > EQ screen



SSMCS (Sweet Spot Morphing Channel Strip) screen

Main screen
The Sweet Spot Morphing Channel Strip is a channel strip effect that uses Sweet Spot Morphing Technology
developed by Yamaha. This lets you use a single knob to adjust the EQ and compressor to the optimum
balance, and works for effects that are difficult to get the optimum effect from without specialized
knowledge, such as the compressor and equalizer.

ab c d e f

g h i j

a [SSMCS] button
Switches the SSMCS (Sweet Spot Morphing Channel Strip) on/off.

b [COMP] button
Switches the compressor on/off.

c COMP graph
Shows your direct operations of the input/output response graph for the compressor.

d [GR] (gain reduction) meter
Shows the amount of gain reduction.

e [EQ] button
Switches the EQ on/off.

f [EQ] graph
Shows the frequency characteristics graph of the EQ.

g [Comp Drive] knob
Sets how much the channel strip compressor is applied.
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h [Morphing] knob
Adjusts the parameter of the Sweet Spot Data. You can simultaneously adjust the compressor and equalizer settings
(Sweet Spot Data), which are set at five points around this knob by turning this knob. When you set the knob to the
middle of two adjacent points, the compressor and equalizer settings will be set to an intermediate value.

i [Sweet Spot Data] button
Tap to select the Sweet Spot Data from the list that’s shown.

j Input/output meter
Shows the input/output signal levels to the SSMCS.
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COMP screen

a

c db e fg h

a [Comp] button
Switches the compressor on/off.

b [SC] meter
Shows the sidechain meter.

c [Comp] graph
Lets you set the compressor by directly operating the input/output response graph.

d [GR] meter
Shows the amount of gain reduction.

e [Knee] mode selector
Switches between the knee parameters (the change in volume before and after the threshold level).

f [Attack] text box
Sets the attack time.

g [Release] text box
Sets the release time.

h Input/output meter
Shows the input/output signal levels to the SSMCS.
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COMP Side Chain screen

a

c deb fgh i

a [Comp] button
Switches the compressor on/off.

b [SC] meter
Shows the sidechain meter.

c COMP graph
Displays the input/output response graph of the compressor.

d [GR] (gain reduction) meter
Shows the amount of gain reduction.

e [Side Chain] button
Toggles the sidechain filter on/off.

f [Q] text box
Sets the Q value.

g [Frequency] text box
Sets the frequency.

h [Gain] text box
Sets the gain.

i Input/output meter
Shows the input/output signal levels to the SSMCS.
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EQ screen

a b

c d

a [EQ] button
Switches the EQ on/off.

b Band name display
Shows the selected band name. Touch to switch the band on/off.

c [EQ] graph
Lets you set each band by directly operating the EQ graph.

d Input/output meter
Shows the input/output signal levels to the SSMCS.
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INS FX screen
This screen is for configuring the inserted effects.

a b

a Effect menu popup button
Shows the screen for selecting the effect type. The effect that’s shown differs depending on the selected channel.
After selecting the effect, the assigned effect name is shown.

b Input/output meter
Shows the input/output signal levels to the INS FX.

NOTE
For details on the parameter settings of each effect, refer to the “Effect Reference Guide” (link shown below). For the effect limitations,
refer to the “Effect list” (p.196).
https://manual.yamaha.com/audio/music_audio_production/effect_rg/
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DUCKER screen

c

a b d e

a [DUCKER] graph
Shows the settings of the ducker in a visual way. Directly control the graph to set the attenuation amount for the R
(Range) effect, the time from exceeding the threshold to full attenuation for the A (Attack Time), and the time from
falling below the threshold to returning to the original volume for the D (Decay Time).

b [GR] (gain reduction) meter
Shows the amount of gain reduction.

c [Ducker Source] select button
Selects the ducker source.

d [Threshold] text box
Sets the threshold.

e Input/output meter
Shows the input/output signal levels to the ducker.
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DELAY screen

a

b c

a [Frame rate] select button
Sets the frame rate.

b [Delay Time] knob
Sets the delay time for each of the units.

c Input/output meter
Shows the input/output signal levels to the delay.
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SEND TO screen
This screen is for configuring the MIX SEND and FX SEND settings.

b c

d a

a Send switch buttons (side menu)
Switches the send destination channels (buses) shown onscreen

b [ON] button
Switches the sends on/off.

c [PRE] button
Switches the send point to the send destination channel to a prefader.

d [Pan] slider
Sets the panning for the send. This can be shown/operated for mix buses whose bus type is VARI and whose signal
type is STEREO.

For MIX channels, an [ON] button is shown that sets the send from the MIX channel to the stereo bus on/off.
The send point is fixed as post-fader.
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Simple mode operation guide
How to access simple mode

1 Open the [SETUP] screen and touch [Operation Mode] at the top left of the screen.

2 Select [Simple Mode] and touch [Next].
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3 Select the mixer configuration method from the screen that’s shown.

Preset: Allows quickly recalling default settings for specific use cases. This is useful when you
want to start simple without making complex settings.

Setup Assistant: Allows connecting input devices, headphones, speakers, and other devices
by following instructions displayed on the screen. This is recommended if you are using a
mixer for the first time.

Scene: Allows recalling and using previously saved settings.

NOTE
For an overview of presets and use cases, refer to p.127.

4 Follow the onscreen instructions to proceed with the settings.
Select or input the necessary items on each screen and touch [Next] to go to the next step. The HOME
(Overview) screen in Simple Mode is shown once you’ve finished with the settings.
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n Quick tour

In Simple Mode, a simple explanation (quick tour) of how to use the mixer screen is shown. The quick tour is
shown every time you select “Setup Assistant” or “Preset”.

NOTE
It is not shown when you select “Scene”.

When you select [Don't show again] at the end of the quick tour, the quick tour does not appear again from
the next time onward. To show the quick tour again, you must initialize the setting on the maintenance
screen (p.181).
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Selecting the presets and use cases

Selection menu screen
When you select “Preset” or “Setup Assistant” in “Start Setup”, a selection menu is shown for the presets or
use cases. Refer to the next page for the explanation of each menu.
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“Live music, event” overview
This setting is designed for small live performances at shops or similar venues, live music on small-scale
stages, events held at venues or open spaces and so forth. This lets you make simple adjustments to the
volume balance.

Mixer routing diagram

1

STEREO STEREO OUT

Computer

For BGM playback
(USB MAIN A)

Mix
for speakers

Monitor for operator
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“Streaming” overview
This setting is designed for simple streaming done by a single person, such as karaoke, a performance on a
musical instrument, a conversation and so forth. The person doing the streaming can adjust the volume
balance between the streaming mix and the mix heard for monitoring in headphones.

Mixer routing diagram

1

BGM/
streaming check

(USB MAIN A)

Streaming mix

Monitor mix

STREAM→USB MAIN A

MONITOR1→PHONES 1

STEREO

MIX 1/2

Streaming via 
computer
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“DAW recording” overview
This setting is designed for easy multitrack recording using a DAW. The audio from a mic, guitar or other
instrument can be monitored in headphones and recorded to your DAW. Further, you can output the
playback sound from the DAW to speakers for checking the results of your recording, editing and mixing.

The mixer routing is shown in the diagram below.

1

(IN MGX16V 1)

(IN MGX16V 2)

(IN MGX16V 3)

(OUT MGX16V 2)
(OUT MGX16V 1)

PC
DAW

For DAW playback
(USB DAW 1/2)

Mix for speakers

Monitor mix

STEREO

MIX 1/2 MONITOR1→PHONES1

STEREO OUT

For DAW recording
(USB DAW 1–16)
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Simple mode screens

HOME (Overview) screen layout

Input area

Toolbar

Output area

Multi-function knob
toggle button
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Toolbar

a b c d e

a Shows the [SCENE] screen. (p.74)

b Shows the [SOUND PAD] screen. (p.78)

c Shows the [SETUP] (settings) screen. (p.51)

d
Shows the [microSD] screen. “ / ” is shown when the microSD is playing back or recording data. (p.84)

e Accesses the [HOME] screen from various other screens.
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Input area

Touch the buttons aside from the ON button or the level knobs to select them. Touching a selected channel
again shows the “Channel view screen” (p.138).

n Channel view

a

b

c

d

a Channel name area
Shows the name of the selected channel. You can’t change the names when in Simple Mode.

b ON button
Turns the channel on/off.

c Level knob
Control the channel’s level from the multi-function knob below the display.

The volume balance for the stereo mix can be set using the faders on the top panel. This cannot be controlled from
the screen.

d Input meter
Shows the level for the channel directly after input.

Stereo channels are shown with a stereo meter.
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NOTE
( Channels that are specified in the setup assistant as having no input are disabled. Touch the “+” button to bring up the setup

assistant again.

( For the PAD and FX1 channels, the screen does not switch to channel view even when you touch the respective areas.

n Channel display selector

Press the “<” and “>” buttons to switch between the display input channels, three at a time.

For MGX16V, MGX16
1, 2, 3, │ 4, 5, 6, │ 7, 8, 9/10, │ 11/12, 13/14, 15/16, │ PAD, FX1, (BLANK)

For MGX12V, MGX12
1, 2, 3, │ 4, 5/6, 7/8, │9/10, 11/12, PAD, │ FX1, (BLANK), (BLANK)

NOTE
( You can also switch between channels by swiping the display section left or right on the input channel.
( The input channel display can also be switched by pressing each button for “-----”.
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Mix selection and output area

n Mix selection

This selects the mix used for adjusting the volume balance. The mix that’s being adjusted is shown on the
left.

Touch the mix shown at right to swap the mixes.

NOTE
If you’ve selected “Live music, event”, only one mix can be used, so only the mix being adjusted is shown.

n Output area

b

a
f

c

d

e

a  icon
Indicates that the mix being adjusted is being monitored in [PHONES] 1.

b Output destination icon/port name
Shows the icon for the output destination port and the port name.

c ON button
Switches the mix output on/off.
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d Level knob
Adjust the output level with the multi-function knob below the display.

If STEREO OUT is selected, set the level with the fader on the top panel.

e Output meter
Shows the output level after adjusting the volume. Stereo channels are shown with a stereo meter.

f Mix display
This shows the mix that isn’t being adjusted. Here you can see the output port icon, on/off indicator, output level and
output meter. Touch this button to swap the mix with the mix at left, so that it is targeted for volume balance
adjustment.

n Multi-function knob toggle button

To adjust the “PHONES 1” volume, touch this button and operate the targeted parameter.

NOTE
If USER DEFINED KNOBS mode is on for the multi-function knobs, the d level knob can’t be operated.
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Example of parameter operation: “Streaming” use case
To control the parameters for STREAMING OUT and PHONES 1, touch the mix in the output area to switch to
it.

n When the STREAMING OUT mix is selected

Operate the faders from each channel to adjust the STREAMING OUT volume balance. You can’t control this
using the multi-function knobs.

n When the [PHONES 1] mix is selected

Operate the [SEND] knob for each channel to adjust the PHONES 1 volume balance. This can also be
controlled using the multi-function knobs. When the level knobs for each channel are orange, this indicates
that the volume balance of the PHONES 1 mix is being adjusted.

NOTE
The volume balance between the STREAMING OUT mix for streaming and the PHONES 1 mix for monitoring in headphones can each
be adjusted flexibly. For example, if you want to stream karaoke, you can adjust the volume so that the CH1 mic input audio for the
STREAMING OUT mix is louder and the PHONES 1 mix is quieter.
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Channel view screen

a

d

b c

a  (HOME) button
Returns to the HOME (Overview) screen in simple mode.

b Main area
Selects a sound while audio is being input. You can swipe the icon to change the sound. A white border is shown for
the selected sound.

NOTE
( The audio changes depending on the selected values in the d channel setting area, even for the same sound.
( In DAW mode, only the [Dry] sound is available, so that the inputted audio can be sent to the DAW as-is. The reverb button will be

disabled.

c [Reverb] button
Switches the reverb on/off. Light blue is the “on” setting.
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NOTE
( With [FX 1 Reverb] selected on the HOME (Overview) screen (p.131) in Simple Mode, you can use the multi-function knobs to adjust

the strength of the reverb overall.
( The reverb may automatically turn on, depending on the sound that’s selected.

d Channel setting area
A screen for reconfiguring the settings for connecting and using the unit is shown when you touch each button.

Screen example
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Sound-related operations
Operating the gate from the HOME screen (Overview)

1 From the Overview screen, select the channel for which you want to set the gate,
and touch the channel indicator area to switch to channel view.

2 Touch the [GATE] button to switch the gate on.

3 To adjust the gate values, touch the [GATE] area and configure the settings in the
GATE screen that’s shown.

Related links
“GATE screen” (p.109)
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Operating the compressor from the HOME screen
(Overview)

1 From the Overview screen, select the channel for which you want to set the
compressor, and touch the channel indicator area to switch to channel view.

2 Touch the [COMP] button to switch the compressor on.

3 To adjust the compressor values, touch the [COMP] area and configure the settings
in the COMP screen that’s shown.

Related links
“COMP screen” (p.110)
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Operating the gain from the HOME screen (Overview)

1 From the Overview screen, select the channel for which you want to set the gain,
and touch the channel indicator area to switch to channel view.

2 Select the INPUT area.

3 On the INPUT screen that’s shown, use the [A.Gain]/[D.Gain] knob to adjust the
gain value.

Related links
“INPUT screen” (p.106)
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Operating the EQ from the HOME screen (Overview)

1 From the Overview screen, select the channel for which you want to set the EQ,
and touch the channel indicator area to switch to channel view.

2 Touch the [EQ] button to switch the EQ on.

3 To adjust the EQ values, touch the EQ graph area and configure the settings in the
EQ screen that’s shown.

Related links
“EQ screen” (p.112)
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Operating the insert from the HOME screen (Overview)

1 From the Overview screen, select the channel for which you want to set the effect,
and touch the channel indicator area to switch to channel view.

2 Touch INS FX area in the toolbar to display the INS FX screen.

3 Touch the Effect menu popup button to show the effect selection screen, and select
the effect you want to insert.

4 To control the effect parameters, touch the effect area and configure the
parameters in the parameter settings screen.

Refer to the “Effect List” for the effects you can insert.

Related links
( “Effect list” (p.196)
( “INS FX screen” (p.119)
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Operating the SSMCS from the HOME screen (Overview)

1 From the Overview screen, select the channel for which you want to set the SSMCS,
and touch the channel indicator area to switch to channel view.

NOTE
If the SSMCS is not shown, touch the channel settings screen display button at the top left of the screen to display the
channel settings screen, and switch the [COMP/EQ] setting from [COMP->EQ] to [SSMCS]. Touch the “Back” button to return
to channel view.

2 Touch the [SSMCS] button to switch the SSMCS on.

3 To adjust the SSMCS values, touch the SSMCS area and configure the settings in the
SSMCS screen that’s shown.

Related links
( “Channel settings screen” (p.97)
( “SSMCS (Sweet Spot Morphing Channel Strip) screen” (p.114)
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Operating the ducker from the HOME screen (Overview)

1 From the Overview screen, select the channel for which you want to set the
ducker, and touch the channel indicator area to switch to channel view.

2 Touch the [DUCKER] button to switch the DUCKER on.

3 To adjust the DUCKER values, touch the DUCKER area and configure the settings in
the DUCKER screen that’s shown.

Related links
“DUCKER screen” (p.120)
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Operating the delay from the HOME screen (Overview)

1 From the Overview screen, select the STREAMING channel, and touch the channel
indicator area to switch to channel view.

2 Touch the [DELAY] button to switch the DELAY on.

3 To adjust the DELAY values, touch the DELAY area and configure the settings in the
DELAY screen that’s shown.

Related links
“DELAY screen” (p.121)

147

Sound-related operations > Operating the delay from the HOME screen (Overview)



Setting the SEND TO from the HOME screen (Overview)

1 From the Overview screen, select the channel for which you want to set the SEND
TO, and touch the channel indicator area to switch to channel view.

2 Touch the [SEND TO] button to configure the settings in the SEND TO screen that’s
shown.

Related links
“SEND TO screen” (p.122)
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Other operations
Storing a scene

1 From the SCENE screen → [Scene List] , select the (slot of the) number you want to
save.

2 Touch the [Store] button to show the scene title input screen.

3 Input the desired title name on the screen that’s shown, and touch the [OK]
button.

4 Once the confirmation screen appears, touch the [OK] button to store the scene.

Related links
“SCENE screen” (p.74)
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Recalling a scene

1 From the SCENE screen → scene list, select the (slot of the) number you want to
recall.

2 Touch the [Recall] button to recall the scene.

Related links
“SCENE screen” (p.74)
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Deleting a scene

1 From the SCENE screen → scene list, select the (slot of the) number you want to
delete.

2 Select [Edit] from the side menu.

3 From the scene list, select the (slot of the) number you want to delete.

4 Touch the  button and tap [OK] on the dialog box that’s shown to delete the
scene.

Related links
“SCENE screen” (p.74)
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Changing the scene title

1 From the SCENE screen → scene list, select the (slot of the) number you want to
edit.

2 Select [Edit] from the side menu.

3 From the scene list, select the (slot of the) number you want to edit.

4 Touch the  button. After inputting the new title name on the screen that’s
shown, tap the [OK] button to change the title.

Related links
“SCENE screen” (p.74)
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Recording to a microSD card

1 From the toolbar, touch  and touch [Recorder] on the screen that’s shown.

2 Touch [Source] in the list that’s shown to select the source you want to record for
each channel.

3 Touch the [REC] button to set the unit to record standby mode. The [REC] button
flashes when the unit is in record standby mode.

4 Touch the [Play/Pause] button to start recording. The recording time is shown and
the counter advances during recording.

5 To stop recording, touch the [Stop] button. A filename is automatically given to the
data that you record.

NOTE
Touch the [Play/Pause] button during recording if you wish to pause recording. The [Play/Pause] button lights up red while the unit is
paused.

Related links
“microSD screen” (p.84)
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Playing back a recording from a microSD card

1 From the toolbar, touch  and touch [Recorder] on the screen that’s shown.

2 Touch [Play] in the side menu.

3 Select the file you want to play from the list of files that can be played back.

4 Touch the [Play/Pause] button to play back the file.

NOTE
( Pressing the [TOUCH AND TURN] knob and selecting a different file during playback will stop the file that’s playing back. The file

you selected starts playing after that.
( Each time you press the knob while the file that’s playing back is selected, the operation repeatedly switches between playback

and pause.

Related links
“microSD screen” (p.84)
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Using the monitor function

1 Connect the monitor system to the OMNI OUT connectors on the top panel.

2 Touch  on the toolbar, and operate from the [Monitor] menu on the [MONITOR]
screen.

3 From [Setting] in the submenu, select the monitor source from Source.

4 To enable the monitor function, touch the [ON] button.

5 Turn the knob to adjust the monitor level.

Related links
“Monitor menu” (p.69)
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Using the PHONES

1 Touch  on the toolbar, and operate from the [Phones] menu on the [MONITOR]
screen.

2 Check the PHONES source in MONITOR 1–4.

The PHONES source outputs from MONITOR 1–4.

3 Turn the knob to adjust the monitor level.

Related links
“Phones menu” (p.71)
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Using the oscillator
Use this for checking the output of your speakers or when performing a line check.

1 Touch  on the toolbar, and operate from the [Oscillator] menu on the
[MONITOR] screen.

2 Select the playback mode in Oscillator Mode. You can set the frequency and so on,
depending on the mode.

3 For the oscillator output destination, you can assign the desired channel from
[Assign] in the submenu.

4 Touch the [ON] button to begin output.

5 Turn the knob to adjust the oscillator level.

Related links
“Oscillator menu” (p.72)
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Using the cue function
This explains how to use the [CUE] button in the HOME screen (Overview) or the dedicated channel screen to
monitor the cue signal.

1 From [Setting] in the [Monitor] menu, turn “CUE Interruption” on.

2 Touch the [CUE] button in the HOME screen (Overview) or the dedicated channel
screen to turn [CUE] on.

NOTE
When [CUE] is on in the HOME screen (Overview), the CUE indicator appears, and the CUE bus meter is shown. When you touch the
meter area at this time, all of the [CUE] can be turned off.

Related links
( “Main area” (p.45)
( “Monitor menu” (p.69)
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Using the SOUND PAD

Recording to the SOUND PAD

1 Touch  in the toolbar and touch [Pad Record] in the menu that’s shown.

2 Touching the pad number you want to record shows the recording menu screen.

3 Getting ready to record

When you touch the [Rec] button, the button flashes and the unit enters record standby mode.

To cancel record ready, touch the [Stop] button.

4 Starting the recording

When you touch the [Play] button, the [Rec] button lights up and recording begins.

Touch the [Stop] button to stop recording. Even if you don’t touch the [Stop] button, recording
will automatically stop once the maximum recording time elapses.

5 Stopping and saving the recording

Once recording is finished, touch the [Apply] button to save the data.

To discard the recorded data and return to record standby mode, touch the [Cancel] button or

.

NOTE
( The audio for STEREO channels (after the signal passes through the faders) is converted to monaural for recording.
( As the data size is fixed, according to the available recording time, it changes based on the sampling frequency.

( 44.1 kHz/48 kHz: approx. 10 seconds
( 88.2 kHz/96 kHz: approx. 5 seconds
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Using the sound source from a recorded SOUND PAD for
playback

1 Touch  in the toolbar and touch [Pad Play] in the menu that’s shown.

2 To play back the audio, touch the pad number you want to play back.

The audio playback method depends on the mode you set. Refer to “Pad Setting menu” (p.80)
for how to set the playback method.

Playback method mode
[One Shot]: Each time you touch this button, the data plays back once from the beginning.

[Hold]: The data plays back repeatedly while you are touching this button. Release your finger from the
button to stop.

[Loop]: The data plays back repeatedly when you touch this button. Press the button again to stop.

Related links
“SOUND PAD screen” (p.78)
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Configuring Sound Pad in the Device Center (V1.2 and later)

1 Make sure that this product is connected via USB cable to a computer that has
TOOLS for MGX/URX installed.

2 Launch Device Center to show the device list screen.

Use the following steps to launch Device Center and access the Device List screen.
( Windows: Launch Device Center from the notification area on the taskbar

( Mac: In the Applications folder, launch Device Center

3 On the device list screen in Device Center, select the MGX for which you want to
configure the Sound Pad.

4 Click  (SOUND PAD).
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5 Select the pad to edit at the top of the screen.

6 At the bottom of the screen, you can edit the following for the selected pad:
“Change name (rename)”, “Pad button color setting”, “Playback Mode setting”,
“Pad output level setting”, “Pan setting” and “FX1/FX2 send level setting”.

NOTE
The setting contents are the same as those found in the “Pad Setting menu” (p.80).
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Assigning an audio file to a sound pad (V1.2 and later)
You can load an audio file in WAV, FLAC or MP3 format that’s saved on your computer or iPad, adjust the
length and assign it to the SOUND PAD [1]–[8] on the MGX.

1 Click the  (waveform) field at the bottom of the [SOUND PAD]
screen in Device Center.

The following screen is shown.

2 Select the audio file you want to assign, and press the [Open] button.

This loads the audio data into Device Center, while at the same time sending the data to the
MGX.

NOTE
( You can’t operate [SOUND PAD] [1]–[8] on the MGX while data is being transmitted.
( The data you can save depends on the sampling frequency of the MGX.

A maximum of 10 seconds of 16-bit data (44.1 kHz/48 kHz) or a maximum of five seconds of 88.2 kHz/96 kHz data (monaural linear
PCM) is saved on the MGX.

( Audio files that exceed the above data lengths cannot be loaded.

NOTICE
( Do not turn off the power of this product, quit Device Center or unplug the USB cable while data is being transmitted.
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Assigning functions to the user defined knobs

1 Touch  in the toolbar and touch [User Defined Knobs] in the menu that’s shown.

2 Touch the bank number you want to set from [Bank].

3 When the knob ID (A–D) of the bank you selected is shown, touch the knob ID you
want to set.

4 Select the function to assign from the screen that’s shown. Once you’ve finished
making the settings, touch the [OK] button to close the dialog box.

When USER DEFINED KNOBS mode is on, the selected Function and Parameter names are
shown at the bottom of the screen in abbreviated form.
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5 Follow the same steps to set the functions for knobs ID (B–D).
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Assigning functions to the user defined keys

1 Touch  in the toolbar and touch [User Defined Keys] in the menu that’s shown.

2 Touch the bank symbol you want to set from [Bank].

3 When buttons 1–8 of the bank you selected are shown, touch the button number
you want to set.

4 Select the function to assign from the screen that’s shown. Once you’ve finished
making the settings, touch the [OK] button to close the dialog box.

5 Follow the same steps to set the functions for buttons 1– 8.
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Updating the firmware

1 Make sure that this product is connected via USB cable to a computer that has
TOOLS for MGX/URX installed.

2 Access the Device List screen in Device Center.

To update the firmware for this product, use the device configuration software [Device
Center]. [Device Center] is included with TOOLS for MGX/URX. Use the following steps to
launch Device Center and access the Device List screen.
( Windows: Launch Device Center from the notification area on the taskbar

( Mac: Launch Device Center from the Applications folder

3 On the Device Center device list screen, select the MGX for which you want to
update the firmware.

4 Disconnect all Yamaha products other than the selected MGX from your computer.

167

Other operations > Updating the firmware



5 Click [ ] (Firmware Update).

6 Follow the onscreen instructions to update the firmware.

7 When the screen indicating the update is complete appears, click [Close].

Now you’re finished with the firmware update.
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Using the Software Integration functions
(V1.2 and later)
Getting ready (DAW Integration)

DAW Integration is a function for controlling this product via software, including input/output to or from DAW
software and linking the routing. Software that is compatible with DAW Integration includes Steinberg
Cubase, Nuendo and MixKey. By using this function, you can use hardware mixing to create a comfortable
monitoring environment that’s free from latency.

To use the DAW Integration function, you must prepare the following three items, as necessary.

( Install TOOLS for MGX/URX (p.20)
TOOLS for MGX/URX V1.1.0 or later must be installed. If the currently installed version is old, install the
latest version.

( Update this product’s firmware (p.167)
Update the firmware to the latest version.

( Install compatible software
Install Steinberg Cubase, Nuendo or MixKey on a computer that contains an installation of TOOLS for MGX/
URX V1.1.0 or later. Visit the following websites for information on the respective software titles.
( Cubase/Nuendo: https://www.yamaha.com/2/mgx-software-1/
( MixKey: https://www.steinberg.net/mixkey/
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Steps for configuring DAW Integration

1 Connect a computer on which compatible software is installed to the [USB MAIN]
port of this unit.

2 Launch the compatible software.

This unit and the software will be linked together, and the DAW Integration screen appears.

3 Operate the software to configure this unit.

See “Using in tandem with a DAW” (p.172) for how to configure the settings using the software
and for the linkage function.
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NOTE
About the DAW Integration operating limitations

In contrast with Standard Mode, the following functions are mainly unavailable.
( Faders on the top panel of this unit, [ON] key (fixed ON), [CUE] key, etc
( Stereo bus, STEREO channel
( SCENE (scene) functions
( microSD recorder functions
( Sound pad recording functions
( When direct monitoring for the compatible software is on: the send signal to the MIX bus from the channel targeted for MONO IN is

controlled via software. The following screen is shown on the unit, and operations are unavailable.

n About the signal flow when DAW Integration is operating

The signals from the DAW software are directly connected to the MIX bus and FX bus. The input sources for
each channel cannot be used to select USB DAW.

Refer to the “Block diagram” (p.204) to see which bus the signal names that are visible from the DAW app are
connected to.

n Canceling DAW Integration

DAW Integration is automatically canceled when quitting the software or when the connection with the
computer has been interrupted. When this happens, the unit returns to Standard Mode.
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Using in tandem with a DAW

Dedicated screens for the Cubase Series
These screens are for configuring the settings of this unit using the Cubase Series. There are two screens, an
input settings screen and a hardware settings screen.

Input settings screen Hardware settings screen
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How to open the screens

Input settings screen
From the Cubase Series menu, create an audio track from [Project] → [Add Track] → [Audio], and click the
[MGXxxx] tab that’s shown in the inspector on the left side of the screen (“xxx” indicates the model you are
using).

Hardware settings screen
From the Cubase Series menu:

Open [Studio] → [Studio Setup], and select [Yamaha MGX/URX] from [Steinberg I/O] on the left side.
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Input settings screen

Header area
This area shows the connected device names.

a

a Model
Shows the name of the model (MGXxxx) to be operated. Click to show/hide the input settings screen.

Hardware input settings area
This area is for configuring the parameters related to the inputs on this unit.

a

b
c
d e

f g

a Port name
Shows the device port name for the input bus.

b Stereo link
This lets you set operation modes for two adjacent channels (CH1/2, CH3/4, etc.). When this is on, the channels are
stereo linked (STEREO), and when this is off, the channels are independent (MONO × 2).

c +48V
Switches +48 V on/off.

d Input meter
Shows the input level.

e Clip indicator
Lights up when the input signal is clipping. Click to turn the indicator off.

f High-pass filter
Switches the HPF (high-pass filter) on/off.

g Phase
Switches the signal phase inversion (180º) on/off. For stereo signals, “LR” is shown.
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Channel strip setting area
This area is for configuring the parameters related to the channel strips (channel signal processing) on this
unit.

a
b

d
c

a RecOutPoint
Selects the point within the signal path from which to directly record (extract) the signal of a channel. Click the icon
to switch between extraction points.

b GATE/COMP/EQ/SSMCS/INS FX
Switches the GATE, COMP, EQ, SSMCS, and INS FX on/off.

For COMP and EQ, the settings are shown when the COMP/EQ setting of this unit is COMP -> EQ.

For SSMCS, this is shown when the COMP/EQ settings on this unit are SSMCS.

c FX1/FX2 send
Adjusts the amount of signal sent to FX1/FX2 (in other words, the amount of effects applied).

Range: -∞ dB to +10.00 dB

d FX1/FX2 name
Shows the type name of the selected effect.
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Output area
This area is for configuring the parameters related to the output channels on this unit.

a

c d

e

b

a Mix Bus name
Shows the hardware mix bus for this unit. The output bus of the tracks must be connected to this mix bus.

b EQ/INS FX
Switches the EQ and INS FX on/off.

c Output meter
Shows the meter for the MIX channels on this unit to which the track output bus is connected.

d Clip indicator
Lights up when the input signal is clipping. Click to turn the indicator off.

e Monitor select button
Selects the monitor (1–4) used for outputting the signal.

n Direct monitoring function settings

By turning direct monitoring on, you can create a latency-free monitoring environment. Make the settings as
follows.

Windows
From the Cubase Series menu, go to [Studio] → [Studio Setup] → [Yamaha Steinberg USB ASIO] → select the
[Direct Monitoring] check box → [OK].

Mac
From the Cubase Series menu, go to [Studio] → [Studio Setup] → [Yamaha MGXxxx DAW] or [Yamaha MGXxxx
DAW (High Precision)] → select the [Direct Monitoring] check box → [OK].

176

Using the Software Integration functions (V1.2 and later) > Using in tandem with a DAW



Hardware settings screen
This screen shows the information for the settings of this unit and the linkage function settings related to
Cubase.

a

b

a model
Shows the name of the connected model.

b DAW Integration
If the check box is selected, the DAW Integration expanded functions are enabled. If the check box is not selected, the
expanded functions are disabled, and the unit will not be linked with Cubase from the next time it starts up.

NOTE
See the Cubase Series Owner’s Manual for other details on how to use the Cubase Series.
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MixKey channel editor
By using the channel editor in the MixKey app, you can configure the parameters of this unit from the MixKey
app.
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How to open the screens

1 Click  to open the mixer/settings screen.

2 From [Settings], click [Audio].

3 In [Audio System], select the driver as follows.

Windows
Select [Yamaha Steinberg USB ASIO]

Mac
Select [Yamaha MGXxxx DAW] or [Yamaha MGXxxx DAW (High Precision)]

4 In [MONITOR OUTPUT], select the port of the MGX model for ASIO Output Devices.

5 Click  to close the mixer/settings screen.

1, 51, 5

22

33

44

6 Click  to add the sound input source. In the source, select the port of the MGX
model from Yamaha Steinberg USB ASIO (Windows) or Yamaha MGXxxx DAW/
Yamaha MGXxxx DAW (High Precision) (Mac).
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7 Click  to open the channel editor.

The input settings screen appears at the bottom right of the channel editor.

7766

The settings screen that’s shown is the same as the Cubase Series “Input settings screen” (p.174). There is no
screen for the MixKey that corresponds to the Cubase Series hardware settings screen.
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Restoring the factory settings
Initializing this unit

NOTE
All the data saved on this unit is lost when it is restored to its factory settings, so consider this carefully before doing so.

1 Turn the power on while pressing the [HOME] key, or hold down the rightmost
multi-function knob while turning on the power.

2 Once the initialize screen is shown, select the menu to execute from the left side of
the screen and touch the [Initialize] button.

(V1.2 and later)

[Initialize All Memories]
This reverts the entire memory to the factory default settings, including the scene memories
and the Sound Pad playback data.

(V1.2 and later) This reverts the entire memory (except for the Sound Pad playback data) to
the factory default settings.

[Initialize Current Memories]
This reverts the current memories (except for the scene memories and Sound Pad playback
data) to the factory default settings.

[Initialize Sound Pad Data] (V1.2 and later)
This reverts only the Sound Pad playback data to the factory default settings.

3 Once the confirmation dialog box appears, touch [OK].

This initializes the data.

181

Restoring the factory settings > Initializing this unit



Mounting the unit to an EIA standard rack
Installing a separately sold rack mounting kit (RK-
MGX16, RK-MGX12)

CAUTION
( Be sure to follow the instructions found in this guide, and assemble the product according to the steps. Retighten the screws

and bolts periodically. Failure to do so may cause the unit to fall off or topple over, causing injury or damage.
( Do not leave screws or other small parts within reach of small children, as they might accidentally ingest the parts.

NOTICE
( Precautions for rack mounting operation

This product is guaranteed to operate within 0–40°C. If mounted in an EIA standard rack with other equipment, the heat from
each device raises the temperature inside the rack, which may prevent it from performing fully. To prevent heat buildup, mount
the product in a rack only under the following conditions.

( Leave at least 1U between it and other devices when mounted with devices that tend to generate heat, such as power
amplifiers. Further, ensure sufficient ventilation by installing a ventilation panel in the space, or simply leave it open.

( Bluetooth may not work if the built-in antenna is hidden when rack mounting the unit.

1 Make sure that the power is off.

CAUTION
( When installing the rack mounting kit, make sure that this unit is powered off, and use the included screws. Failure to do so may

result in product failure or electric shock.
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2 Install the rack mounting brackets.

Secure the rack mounting brackets to the unit with the six screws included with the rack
mounting kit. Make sure there is no looseness in the rack mounting brackets.

3 Install this unit into the rack.

We recommend ensuring at least 10U* of space in order to connect the cables.
*10U is approximately 445 mm.

8U
10U
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Frequently asked questions
Troubleshooting (audio)

No sound is heard

n Connection-related causes

( The device connection may not be appropriate
Make sure that external devices such as mics, as well as monitor speakers are connected correctly.

( The cable may be damaged
Make sure that there are no shorts or breaks in the cables.

n External device-related causes

( The monitor speakers may be off
Turn the monitor speakers on.

n Causes related to this unit’s settings

( The input/output signal settings may be inappropriate
In the “INPUT screen” (p.106)/“Output Patch menu” (p.59), check whether the input/output source is
selected appropriately.

( Input gain may be too low
Adjust the gain on the “INPUT screen” (p.106).

( The [ON] key for the corresponding channel is set to off.
Press the [ON] key.

( Phantom power may be turned off
When using a condenser mic, set the [+48V] button on the “INPUT screen” (p.106) to on.

( Output level may be too low
Adjust the output level.

n Computer/software-related causes

( No driver installed on the computer
Install TOOLS for MGX/URX from the Yamaha website listed below. The Yamaha Steinberg USB Driver will
install automatically.
https://www.yamaha.com/2/mgx/
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( Buffer size is too small
Adjust the buffer size on the Yamaha Steinberg USB Driver settings screen.
How to open the settings screens
Windows

( From the Start menu: [Yamaha Steinberg USB Control Panel]
( From the Cubase Series menu: [Studio] → [Studio Setup] → [Yamaha Steinberg USB ASIO] → [Control

Panel]
Mac

( From the Cubase Series menu: [Studio] → [Studio Setup] → [Yamaha MGXxxx DAW] or [Yamaha MGXxxx
DAW (High Precision)] → [Control Panel]
(“xxx” indicates the name of the model you are using)

( Audio settings on the DAW software may be inappropriate
Check the audio settings on your DAW software.
For Cubase
From the Cubase Series menu, open [Studio] → [Studio Setup] → [Audio System], and check whether
[Yamaha Steinberg USB ASIO] (Windows), [Yamaha MGXxxx DAW] or [Yamaha MGXxxx DAW (High
Precision)] (Mac) is selected for the [ASIO Driver] on the right side.
(“xxx” indicates the name of the model you are using)

( The input/output routing may be inappropriate
Check the input/output settings on your DAW software.
For Cubase
Open [Studio] → [Audio Connections] to check the input/output settings.

( The message Audio Format is Unmixable is shown (Mac only)
If Cubase does not quit normally, the error message Audio Format is Unmixable is shown in the Yamaha
Steinberg USB Driver control panel. When this happens, press [Revert to Mixable] to resolve the error.

( Streaming software volume may be too low
If you are using streaming software, adjust the volume in the software.
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Sound is distorted
( The levels on the devices connected to this unit may be too high

Lower the volume of the connected devices.

( The gain settings may be inappropriate
Adjust the gain on the INPUT screen.
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Troubleshooting (other issues)

n Display is too dim

Adjust the Screen and Panel values from the [Brightness] menu.

n The microSD card recording date/time is not correct

When the internal battery wears down, the internal clock stops, and the microSD card recording date/time is
not set correctly. If the display shows a “Low Battery” or “No Battery” warning, contact the retailer where
you purchased the product or a repair service center to request a battery replacement.

n Cannot update the firmware

An error screen is shown if this unit fails to update. To retry the update, click the [Retry] button. To quit, click
the [OK] button.

n Power turns off automatically

Check the settings in the [Power Management] menu (p.65). You can change the auto power off function
settings.
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Appendix
Trademarks

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

Mac, macOS, iPad, iPhone, iPadOS, App Store, and Lightning are trademarks of Apple Inc. registered in the United States
and other countries.

Android is a trademark of Google LLC.

Steinberg and Cubase are registered trademarks of Steinberg Media Technologies GmbH.

The terms HDMI, HDMI High-Definition Multimedia Interface, HDMI Trade dress and the HDMI Logos are trademarks or
registered trademarks of HDMI Licensing Administrator, Inc.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such marks by
Yamaha Corporation is under license.

microSD and the microSD logo are trademarks of SD-3C, LLC.

USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum.

Blu-ray™ is a trademark of the Blu-ray Disc Association.

The company names and product names in this manual are the trademarks or registered trademarks of their respective
companies.
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General specifications
0 dBu = 0.775 Vrms

MGX16V, MGX16 MGX12V, MGX12

Mixing capacity
Input channels 8 mono + 4 stereo + 1 Sound Pad + 2 FX 4 mono + 4 stereo + 1 Sound Pad + 2 FX

Buses 8 MIX + 2 FX + 1 CUE + 1 STEREO

Local connectors

Analog input
8 Mic/Line (8 XLR/TRS Phones Combo)

8 Line (4 TRS Phone, 4 RCA)

4 Mic/Line (4 XLR/TRS Phones Combo)

8 Line (4 TRS Phone, 4 RCA)

Analog output 2 XLR, 8 TRS Phone 2 XLR, 6 TRS Phone

USB to HOST 2 (USB Type-C )

Phones 4 (Stereo Phone)

DC power input 1

HDMI IN 1 (MGX16V, MGX12V only)

HDMI THRU 1 (MGX16V, MGX12V only)

SD card slot 1 microSD card slot

Bluetooth 1

User interface

Display 4.3-inch touch screen

Fader 16 x 60 mm fader 12 x 60 mm fader

Knobs 5 x Rotary Encoder (4 x screen knob, 1 x
TOUCH AND TURN), 16 x SEND knob

5 x Rotary Encoder (4 x screen knob, 1 x
TOUCH AND TURN), 12 x SEND knob

Recording &
playback

USB MAIN
Recording up to 22 tracks

Playback up to 22 tracks

Recording up to 18 tracks

Playback up to 18 tracks

USB SUB Recording 2 tracks / playback 2 tracks

microSD Card Recording up to 16 tracks / playback 2 tracks

Sampling
frequency

Frequency 44.1 kHz / 48 kHz / 88.2 kHz / 96 kHz

Accuracy ±50 ppm

Signal delay Less than 0.4 ms (INPUT to STEREO OUT @ Fs=96 kHz)

Frequency response
+0.0 / −0.5 dB (20 Hz – 20 kHz)

Reference to the nominal output level @ 1 kHz, MIC/LINE INPUT to STEREO OUT

Total harmonic distortion (THD+N)
*1

Less than 0.002% @ 4 dBu (20 Hz to 20 kHz), MIC/LINE INPUT to STEREO OUT, input
gain = min.

Hum and noise *2

−128 dBu typ., equivalent input noise, MIC/LINE INPUT to STEREO OUT, input gain =
max.

Residual output noise: −108 dBu, STEREO OUT = OFF

Dynamic range *3 125 dB typ., DAC to STEREO OUT, 
115 dB typ., MIC/LINE INPUT to STEREO OUT, input gain = min.

Crosstalk @ 1 kHz *4 −120 dB, adjacent INPUT/STEREO OUT channels, input gain = min.

Analog to digital converter (MIC/
LINE) Dynamic range: 120 dB, THD+N:−112 dB

Digital to analog converter (STEREO
OUT) Dynamic range: 130 dB, THD+N: −120 dB

Power requirements DC 16 V/2.4 A, PA-300 power adapter (100 V–240 V, 50 Hz/60 Hz)
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Power consumption
MGX16V: 38.4 W

MGX16: 38.4 W

MGX12V: 38.4 W

MGX12: 38.4 W

Dimensions (W × H × D) 419 mm x 96 mm × 319 mm 335 mm x 96 mm × 319 mm

Net weight
MGX16: 4.7 kg

MGX16V: 4.9 kg

MGX12: 3.9 kg

MGX12V: 4.1 kg

Operating temperature range 0 to 40ºC

Storage temperature range −20 to 60ºC

Included accessories

Start Guide × 1

Safety Guide × 1

Cubase AI License Card × 1

Steinberg Plus License Card × 1

Basic FX Suite License Card × 1

Power adapter (PA-300 including power cord) × 1

Options Rack Mount Kit RK-MGX16 Rack Mount Kit RK-MGX12

*1 Total harmonic distortion is measured with a 20 Hz HPF and 20 kHz LPF.

*2 Noise is measured with a 20 kHz LPF and A-weighting filter.

*3 Dynamic range is measured with a 20 kHz LPF and an A-weighting filter.

*4 Crosstalk is measured with a 1 kHz BPF.

The contents of this guide apply to the latest specifications as of the publishing date.
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Input / Output characteristics

Analog Input Characteristics
0 dBu = 0.775 Vrms

Terminal
(MGX16V,

MGX16)

Terminal
(MGX12V,

MGX12)
Gain

Actual
load

impeda
nce

For use
with

nomina
l

Input level

ConnectorsSensitivity
*1 Nominal Max.

before clip

MIC/LINE 1-8 MIC/LINE 1-4
+70 dB

4 kΩ 150 Ω
Mics

−94 dBu
(15.5 μV)

−74 dBu
(155 μV)

−62 dBu
(616 μV) Combo *2

(Balanced)
−16 dB −8 dBu

(309 mV)
+12 dBu
(3.09 V)

+24 dBu
(12.3 V)

LINE 9/10,
11/12 LINE 5/6, 7/8

High
10 kΩ 600 Ω

Lines

−26 dBu
(38.8 mV)

−6 dBu
(389 mV)

+6 dBu
(1.55 V) PHONE *2

(Balanced)
Low −8 dBu

(309 mV)
+12 dBu
(3.09 V)

+24 dBu
(12.3 V)

LINE 13/14,
15/16

LINE 9/10,
11/12 - 10 kΩ 600 Ω

Lines
−20 dBu
(77.5 mV)

0 dBu
(0.775 V)

+12 dBu
(3.09 V)

RCA pin
(unbalanced)

*1 Input sensitivity refers to the lowest input level that produces an output of +4 dBu (1.23 V) or the nominal output level
when the unit is set to maximum gain, with all faders and level controls at their maximum positions.

*2 Combo and PHONE pin assignments: 1&Sleeve＝GND, 2&Tip＝HOT, 3&Ring＝COLD
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Analog Output Characteristics
0 dBu = 0.775 Vrms

Terminal
(MGX16V,

MGX16)

Terminal
(MGX12V,

MGX12)

Actual
Source

impedance

For use with
nominal

Output level
Connectors

Nominal Max. before
clip

STEREO OUT 300 Ω 10 k Ω Lines +4 dBu
(1.23 V)

+16 dBu
(12.3 V)

XLR-3-32 *1

(Balanced)

OMNI OUT 1-8 OMNI OUT 1-6 150 Ω 10 k Ω Lines −2 dBu
(616 mV)

+10 dBu
(2.45 V)

PHONE *2

(Impedance Balanced)

PHONES 1-4 10 Ω 40 Ω phone 6 mW + 6 mW 100 mW+100
mW Stereo phone *3

*1 XLR-3-32 pin assignments: 1＝GND, 2＝HOT, 3＝COLD

*2 PHONE pin assignments: Tip＝HOT, Ring＝COLD, Sleeve＝GND

*3 Stereo PHONE pin assignments: Tip＝LEFT, Ring＝RIGHT, Sleeve＝GND
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Digital Input/Output Characteristics
Terminal Format Data Length Standard Audio Connectors

USB to Host
[MAIN] PCM

32-bit / Up to 96
kHz

Yamaha Steinberg
USB Driver

MGX16V, MGX16: Up to
22 in / 22 out

MGX12V, MGX12: Up to
18 in / 18 out USB (Type-C, USB

2.0：High Speed)

32-bit / Up to 96
kHz

USB Audio Class
(UAC 2.0)

MGX16V, MGX16: 18 in /
16 out

MGX12V, MGX12: 14 in /
12 out

USB to Host [SUB] PCM 16-bit / Up to 48
kHz

USB Audio Class
(UAC 1.0) 2 in / 2 out USB (Type-C, USB

2.0：Full Speed)

microSD Card Slot WAV 24-bit / Up to 96
kHz

microSDHC/
microSDXC (UHS-I
or higher, Class 10
or higher), exFAT
supported

Recording: 
16 tracks @ 44.1/48 kHz 
8 tracks @ 88.2/96 kHz

Playback: 2 tracks

microSD Card Slot

Bluetooth Audio
Input AAC, SBC 16-bit / Up to 48

kHz
Bluetooth 5.0

A2DP
2 in -

HDMI IN 
*MGX16V, MGX12V
only

PCM Up to 24-bit / 192
kHz HDMI, HDCP 8 in HDMI (Type A)

HDMI THRU (pass-
through)
*MGX16V, MGX12V
only

PCM Up to 24-bit / 48
kHz HDMI, HDCP 2 out HDMI (Type A)

Audio inputs from HDMI, Bluetooth, and USB SUB are converted to match with the Mixer audio format
automatically.
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Video Input/Output Characteristics (MGX16V, MGX12V)
Terminal Resolution Standard Feature Connectors

HDMI IN Up to 4K60, 1440p120,
1080p240 HDMI, HDCP HDR10, HLG, VRR HDMI (Type A)

HDMI THRU (pass-
through)

Up to 4K60, 1440p120,
1080p240 HDMI, HDCP HDR10, HLG, VRR HDMI (Type A)

USB to HOST [MAIN] Up to 4K60, 1440p120,
1080p240

USB Video Class (UVC
1.1) *1 HDR10, HLG USB (Type-C, USB3.2

Gen1, 5Gbps)

*1 Driver-free on Windows/macOS.

The contents of this guide apply to the latest specifications as of the publishing date.
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Bluetooth specifications

Bluetooth

Function Classic Audio

Profile A2DP

Codec SBC, AAC

Bluetooth version 5.0

Frequency range 2402–2480 MHz

Bluetooth power class Class 1

TX power +10.4 dBm (11 mW)

The contents of this guide apply to the latest specifications as of the publishing date.
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Effect list

COMPANDER-H, COMPANDER-S

Supported sampling frequencies 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

Supported channels

Can be used with the INS FX of both the MONO IN channels and the output channels.

When Signal Type is inserted into a stereo channel pair, it operates in stereo.

Note that this cannot be inserted into two mono channels.

Number of simultaneous uses
MONO IN channels: 1 slot; output channels: 1 slot

Note that this cannot be used at the same time as the MULTI-BAND COMPRESSOR.

MULTI-BAND COMPRESSOR

Supported sampling frequencies 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

Supported channels

Can be used with the INS FX of the output channels.

When Signal Type is inserted into a stereo channel pair, it operates in stereo.

Note that this cannot be inserted into two mono channels.

Number of simultaneous uses
1 slot

Note that this cannot be used at the same time as the COMPANDER-H and
COMPANDER-S.

PITCH FIX

Supported sampling frequencies 44.1 kHz, 48 kHz

Supported channels
Can be used with the INS FX of the MONO IN channels.

Cannot be used when Signal Type is stereo.

Number of simultaneous uses 1 slot

GUITAR AMP CLASSICS (Clean, Crunch, Lead, Drive)

Supported sampling frequencies 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

Supported channels
Can be used with the INS FX of the MONO IN channels.

Cannot be used when Signal Type is stereo.

Number of simultaneous uses 1 slot

REV-X (HALL/ROOM/PLATE)

Supported sampling frequencies 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

Supported channels
Can be used with FX1.

Note that this cannot be used at the same time as the MONO DELAY and PING PONG
DELAY.
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REV-R3 (HALL/ROOM/PLATE)

Supported sampling frequencies 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

Supported channels
Can be used with FX2.

Note that this cannot be used at the same time as the MONO DELAY and PING PONG
DELAY.

MONO DELAY

Supported sampling frequencies
[FX1]:44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

[FX2]:44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

Supported channels

Can be used with FX1 and FX2.

With the FX1, this cannot be used at the same time as the REV-X and PING PONG
DELAY.

With the FX2, this cannot be used at the same time as the REV-R3 and PING PONG
DELAY.

PING PONG DELAY

Supported sampling frequencies
[FX1]:44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

[FX2]:44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

Supported channels

Can be used with FX1 and FX2.

With the FX1, this cannot be used at the same time as the REV-X and MONO DELAY.

With the FX2, this cannot be used at the same time as the REV-R3 and MONO DELAY.
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Functions that can be assigned to the user defined knobs
The functions that can be assigned to the user defined knobs are as follows.

Function Parameter 1
Parameter 2

MGX16V, MGX16 MGX12V, MGX12

No Assign --- --- ---

Brightness
Screen --- ---

Panel --- ---

Monitor Monitor 1–4 Level Level

Phones Phones 1–4 Level Level

Oscillator Level --- ---

198

Appendix > Functions that can be assigned to the user defined knobs



Functions that can be assigned to the user defined keys
The functions that can be assigned to the user defined keys are as follows.

Function Parameter 1
Parameter 2

Explanation
MGX16V, MGX16 MGX12V, MGX12

No Assign --- --- --- No assignment

CUE Clear CUE --- --- Clears the CUE.

Monitor Monitor 1–4 ON ON Switches the monitor
on/off.

Oscillator

ON --- --- Switches the oscillator
on/off.

Direct Assign

MIX 1–8 MIX 1–8

Assigns the oscillator to
the selected channel.

FX 1–2 FX 1–2

ST L ST L

ST R ST R

Scene Direct Recall
[Standard] 01–63 [Standard] 01–63 Directly recalls the

desired scene.[Simple] 01–63 [Simple] 01–63

Sends Select

MIX 1–8 Normal, With CUE Normal, With CUE

Switches the send
destination between
MIX 1–8/STEREO.

If you select “With CUE”
in parameter 2, the CUE
on/off status for the
corresponding MIX will
also be linked.

FX 1–2 Normal, With CUE Normal, With CUE

Switches the send
destination between FX
1–2/STEREO.

If you select “With CUE”
in parameter 2, the CUE
on/off status for the
corresponding FX will
also be linked.

Sound Pad PAD 1–8 --- --- Configures the sound
pad.

Tap Tempo Tempo 1-2 --- --- Sets the tap tempo.
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USB MAIN signal name reference table

Windows

Usable regions MGX16V, MGX16 (44.1 kHz,
48 kHz)

MGX16V, MGX16 
(88.2 kHz, 96 kHz)

MGX12V, MGX12
(all sampling frequencies)

Output
signal name
on computer

A 
Yamaha
MGX**

B 
Yamaha
MGX**

C 
Yamaha
MGX**

MGX** 1–16 MGX** 1–12

Recognized as the sound output device on
the computer

Used in the DAW or other software as Yamaha Steinberg USB
ASIO device

Input signal
name on this
unit

USB MAIN A USB MAIN B USB MAIN C USB DAW 1–16 USB DAW 1–12

Output
signal name
on this unit

USB MAIN A USB MAIN B USB MAIN C (CH 1–16 Rec Out) (CH 1–12 Rec Out)

Input signal
name on
computer

A 
Yamaha
MGX**

B 
Yamaha
MGX**

C 
Yamaha
MGX**

MGX** 1–16 MGX** 1–12

Recognized as the sound input device on the
computer

Used in the DAW or other software as Yamaha Steinberg USB
ASIO device

The asterisks (**) represent the model name (16V, 16, 12V, 12)

Mac

Usable regions MGX16V, MGX16
(44.1 kHz, 48 kHz)

MGX16V, MGX16
(88.2 kHz, 96 kHz)

MGX12V, MGX12
(all sampling
frequencies)

Output signal
name on
computer

Yamaha MGX** A Yamaha MGX** B Yamaha MGX** C Yamaha MGX** DAW

MGX**A
L

MGX**A
R

MGX**B
L

MGX** B
R

MGX**C
L

MGX**C
R MGX** 1–16 MGX** 1–12

Input signal
name on this
unit

USB MAIN A USB MAIN B USB MAIN C USB DAW 1–16 USB DAW 1–12

Output signal
name on this
unit

USB MAIN A USB MAIN B USB MAIN C (CH 1–16 Rec Out) (CH 1–12 Rec Out)

Input signal
name on
computer

Yamaha MGX** A Yamaha MGX** B Yamaha MGX** C
Yamaha MGX** DAW

Yamaha MGX** DAW

MGX**A
L

MGX**A
R

MGX**B
L

MGX** B
R

MGX**C
L

MGX**C
R MGX** 1–16 MGX** 1–12

The asterisks (**) represent the model name (16V, 16, 12V, 12)
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iPad/iPhone (MGX16V, MGX16)
When Generic Driver Audio Channel Suppression = None

Output signal on device - - - CH 1–16

Input signal name on this
unit USB MAIN A USB MAIN B USB MAIN C USB DAW 1–16

Output signal name on this
unit USB MAIN A USB MAIN B USB MAIN C (CH 1–16 Rec Out )

Input signal on device CH 17, 18 - - CH 1–16

When Generic Driver Audio Channel Suppression = 2 Channels

Output signal on device CH 1, 2 - - -

Input signal name on this
unit USB MAIN A USB MAIN B USB MAIN C USB DAW 1–16

Output signal name on this
unit USB MAIN A USB MAIN B USB MAIN C (CH 1–16 Rec Out )

Input signal on device CH 1, 2 - - -

iPad/iPhone (MGX12V, MGX12)
When Generic Driver Audio Channel Suppression = None

Output signal on device - - - CH 1–12

Input signal name on this
unit USB MAIN A USB MAIN B USB MAIN C USB DAW 1–12

Output signal name on this
unit USB MAIN A USB MAIN B USB MAIN C (CH 1–12 Rec Out)

Input signal on device CH 13, 14 - - CH 1–12

When Generic Driver Audio Channel Suppression = 2 Channels

Output signal on device CH 1, 2 - - -

Input signal name on this
unit USB MAIN A USB MAIN B USB MAIN C USB DAW 1–12

Output signal name on this
unit USB MAIN A USB MAIN B USB MAIN C (CH 1–12 Rec Out)

Input signal on device CH 1, 2 - - -
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Dimensions

n MGX16V, MGX16

419 96

31
9

Units: mm

The MGX16V is shown in the illustration.
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n MGX12V, MGX12

335 96

31
9

Units: mm

The MGX12V is shown in the illustration.
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Block diagram
See the following Yamaha website for the MGX Series block diagram.

https://www.yamaha.com/2/mgx/

The block diagram is available in the “Technical Specifications” section (English version only) within the
“Owner’s Manual” under the “Download” menu.
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